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InfoQube Data: Items, Fields, Tags and Links

In InfoQube, Data and UI are distinct (unlike a traditional word processor or spreadsheet)

Items are the basic unit of information

Fields values can be assigned to items, such as extra text, numbers, dates and Yes/No (checkbox)

Tags can also be assigned to items. Tags are similar to Y/N fields. They are however easier to create and support inheritance

Links relate items to each other and to the outside world (files and the web)
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Items in InfoQube

In InfoQube, the term item is used to refer to a piece of information. When displaying the item in a grid as in the above picture, an item is a row. In other

types of views, such as the Calendar, Surface, Mindmap, Timeline, etc, items will have different visual representations.

Items can have values. In the above example, the highlighted item has the following field values:

Item [Field] = First iteration coding

Nb Days = 3

Rate = 700

Cost = 2100 $

% Done = 70%

Project = Somiro

Category = Development

Start, End = ...

+ others that aren't seen in the grid, but could be if  the columns for these fields were displayed (like: IDItem, ItemCreated, ItemModified, etc.). These
other filled fields can nevertheless be seen in the 6. Properties Pane.

Item can be organized in outlines (e.g. trees of items). There is no limit to the number of levels in a tree. When items have sub-items (e.g. children), but these

are not shown, the bullet is a +. Single-click on the + will expand/close items.

In InfoQube:

�. All items are full-fledged items. There is no such thing as a top-level item (TLI) or secondary-level item (SLI). Meaning : they don't have any inherent

status or function. An item can be a TLI in one location and not in another - see #4 below

�. Items can have multiple values (field-values). An item can only have one (1) value for any given field (though text fields support a multi-select editor. See

[3272])

�. Items can have multiple sub-items

�. Items can have multiple parents. Yes, like you and me, items can have two parents (or more)
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�. When an item has more than one parent, one of them is marked as the "main parent". 

Some views only display the main parent (Grids, Mapview), others can display all parents (Properties pane, Surface). Others, like the Calendar, do not

display parents at all

�. You can create as many fields as you wish. Details here: 2. Fields

�. System field are shown in grey in the Properties pane and in the Manage Fields dialog

�. There are 4 types of field: Text, Date, Number and Binary (i.e. a Yes/No, a checkmark, a folder)

�. Text fields can include basic formatting, images, hyperlinks, can wordwrap and have no limit on the number of characters.

Some views however display a limited number of characters. For grids, it is around 2000. The Doc pane has no limit, so If you have a single large piece

of text, it is recommended to put it in the Doc pane (see 4. Document Pane)

��. In addition to fields, items have a few properties which are all accessible (include in search, sort, display in grids). These are:

�. ID

�. Created

�. Created by

�. Modified (any field value change updates this)

�. Font

�. Locked

�. Home

��. There are many other special fields, such as NbChildren, NbParents, TextFields which allows for searching in all text fields, the same for dates, numbers

and binary fields

��. InfoQube can be used as a two-pane organizer, where items are shown in a Tree and the content in the Doc pane

But the Doc pane is much more. It can display a web page, a Markdown document, a local file (with transparent edit/save), or rich text content stored in

the database. 

Clip from your browser (see 1. Clipping Content from other Apps) or drag-drop from word processor. Great for large pieces of text, still fully

searchable

It even supports a handwriting word processor, a truly unique feature !

All information relating to items is summarized in the item properties pane:

You want to see the actual dates? No problem. Drag-drop the Created or Modified from the properties pane to the grid!

Also see how to search for items using their properties: 4. Searching and Filtering Items
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(There are important rules to follow for conditional formats to work properly; they are to be found at the end of this page.)

The conditional formatting feature allows you to apply formats (forecolor, backcolor, bold, etc) to a cell or range of cells, and have that formatting change

depending on the value of the cell or the value of a formula. These get applied over the item-level colors.

Tutorial

As an example, you may want to highlight unchecked check boxes since they may require attention (tasks not done for example):

The InfoQube cell backcolor changes automatically as users check/un-check it. Also, note how the Notes cell also changes color.

To achieve this, a few simple steps:

1- Open the "Field management" dialog (View menu --> Manage Fields)

2- Select the InfoQube field (or any other Y/N fields, or boolean fields),

3- add 2 conditional format rules as shown then click Save

4- Select the Notes field,

5- add the conditional format rule as shown below, then click Save.

6- Go to a grid where both fields/columns -- "notes" and "InfoQube" -- are present.

7- Close it and reopen it if it was already open.

8- Now, check (√) or un-check the InfoQube field. You should obtain what is shown in the first screenshot on this page.

 Explanations

What do all these codes mean

Criteria                                    Formats                                                      

<>0 BackColor=&H00FF00



=0 BackColor=&H0000FF

[InfoQube]=0      BackColor=&H00FFFF

=0 and [OK]=0

<>"" Font=Courier New

"=0" means that the Yes/No field is "Null" --> "not checked".      Likewise: for other types of fields it means "Empty"

"<>0" means that the Yes/No field is "not Null" --> "checked".    Likewise: for other types of fields it means "Not Empty" 

<>"" means cell is not empty

How can one field condition the format of another field ?

As shown in step 2, if you want the formatting to be conditioned by another field (here a value in the InfoQube field will affect the Notes field formatting),

you can add a specific field name (enclosed with square brackets) before the "<>0" or "=0"

So, lets say the "Date" field changes color based on whether the ItemHasHTML field is checked or not, you'd :

     a- put the details in the Criteria column in the Date field thus:

     [ItemHasHTML]<> 0

     [ItemHasHTML] = 0

     b- and then add formatting - color, etc. as appropriate. Example :

     BackColor=&hFF9BAF

Other formatting options

Formatting can be applied to any fields.

Bold=1. Bolds the cell

Italic=1.

StrikeOut=1

Underline=1

BackColor=&HBBGGRR: Changes the background color for cell

(BBGGRR stands for hex values of Blue, Green, and Red colors)

ForeColor=&HBBGGRR: Changes the foreground color for cell

Font=Courier New

How can I have multiple conditional formats and/or associate multiple formatting with the same condition ?

      a- You can have as many conditional formats as you wish and activate/deactivate them using the "Use?" check-box.

      b- You can piggyback formatting using the | character:

      Bold=1 | Italic=1 | BackColor=&H00FFFF

              would bold, italic and change backcolor

       c- The criteria can include more than 1 field, such as:

      [Amount] >100 and [PaidBy] = "Credit" 

Enabling conditional formatting for specific grids

There is now a 4th column, named Grids, which enables you to set the grids to apply the conditional format. Enter a | separated list of grid names

Important Notes Concerning Conditional Formatting

�. Conditional format "Criteria" can be for any field types:  Y/N, Numeric, Text and Date Fields

(If it's a Y/N (Boolean) Field, then  the condition is  =<>0 for Y and  =0 for N.)



�. If a columns format is conditioned by another column, both need to be present in the grid for the formatting to happen. The column width can be set

to 0 or even hidden if desired

�. The criteria can include more than 1 field, such as [Amount] >100 and [PaidBy] = "Credit"

�. Operators need to be in lower case (e.g.: and, not AND)

�. Fields need to be enclosed in "[ ]" (e.g.:  [Field] )

�. Text criteria are case sensitive. If you want case insensitive, use the "lower" function (e.g. lower([Notes]) = "work" will match both "Work" and "work").

Details here

�. To match text anywhere in the text field, use the "contains" keyword instead of "=" (e.g.  lower([Notes]) contains "work" will also match "some work left

to do")

Using an external editor

Editing the conditional format settings can be cumbersome. You can use Notepad to edit and function to load the text file back.

To do so, right-click on the conditional format settings column

--
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Conditional Formatting Reference

1. Valid criteria

The following are valid expressions that can be used in the "Criteria" column of the conditional formats. %1, %2, etc are placeholders representing fields.

In IQ you would replace %1 by [Notes] for example

The supported conversion unary operators are:

type (unary operator) retrieves the type of the object. For instance type(%1) = 8 specifies the cells ( on the column 1 ) that contains string values. 

Here's few predefined types:

0 - empty ( not initialized )

1 - null

2 - short

3 - long

4 - float

5 - double

6 - currency

7 - date

8 - string

9 - object

10 - error

11 - boolean

12 - variant

13 - any

14 - decimal

16 - char

17 - byte

18 - unsigned short 

19 - unsigned long

20 - long on 64 bits 

21 - unsigned long on 64 bites

str (unary operator) converts the expression to a string. The str operator converts the expression to a string. For instance, the str(-12.54) returns the

string "-12.54".
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dbl (unary operator) converts the expression to a number. The dbl operator converts the expression to a number. For instance, the dbl("12.54") returns

12.54

date (unary operator) converts the expression to a date, based on your regional settings. For instance, the date(`̀) gets the current date-time, while the

date("01/01/2001") returns #1/1/2001#

dateS (unary operator) converts the string expression to a date using the format MM/DD/YYYY HH:MM:SS. For instance, the dateS("01/01/2001
14:00:00") returns #1/1/2001 14:00:00#

Other known operators for numbers are:

int (unary operator) retrieves the integer part of the number. For instance, the int(12.54) returns 12

round (unary operator) rounds the number ie 1.2 gets 1, since 1.8 gets 2. For instance, the round(12.54) returns 13

floor (unary operator) returns the largest number with no fraction part that is not greater than the value of its argument. For instance, the floor(12.54)
returns 12

abs (unary operator) retrieves the absolute part of the number ie -1 gets 1, 2 gets 2. For instance, the abs(-12.54) returns 12.54

currency (unary operator) formats the giving number as a currency string, as indicated by the control panel. For instance, currency(value) displays the

value using the current format for the currency ie, 1000 gets displayed as $1,000.00, for US format.

value format 'flags' (binary operator) formats the value with specified flags. If flags is empty, the number is displayed as shown in the field "Number" in

the "Regional and Language Options" from the Control Panel. For instance the 1000 format '' displays 1,000.00 for English format, while 1.000,00 is

displayed for German format. 1000 format '2|.|3|,' will always displays 1,000.00 no matter of settings in the control panel. If formatting the number fails

for some invalid parameter, the value is displayed with no formatting. 

The ' flags' for format operator is a list of values separated by | character such as

'NumDigits|DecimalSep|Grouping|ThousandSep|NegativeOrder|LeadingZero' with the following meanings: 

NumDigits - specifies the number of fractional digits, If the flag is missing, the field "No. of digits after decimal" from "Regional and Language

Options" is using.

DecimalSep - specifies the decimal separator. If the flag is missing, the field "Decimal symbol" from "Regional and Language Options" is using.

Grouping - indicates the number of digits in each group of numbers to the left of the decimal separator. Values in the range 0 through 9 and 32

are valid. The most significant grouping digit indicates the number of digits in the least significant group immediately to the left of the decimal

separator. Each subsequent grouping digit indicates the next significant group of digits to the left of the previous group. If the last value supplied

is not 0, the remaining groups repeat the last group. Typical examples of settings for this member are: 0 to group digits as in 123456789.00; 3 to

group digits as in 123,456,789.00; and 32 to group digits as in 12,34,56,789.00. If the flag is missing, the field "Digit grouping" from "Regional and

Language Options" indicates the grouping flag.

ThousandSep - specifies the thousand separator. If the flag is missing, the field "Digit grouping symbol" from "Regional and Language Options" is

using.

NegativeOrder - indicates the negative number mode. If the flag is missing, the field "Negative number format" from "Regional and Language

Options" is using. The valid values are 0, 1, 2, 3 and 4 with the following meanings:

0 - Left parenthesis, number, right parenthesis; for example, (1.1) 

1 - Negative sign, number; for example, -1.1

2 - Negative sign, space, number; for example, - 1.1

3 - Number, negative sign; for example, 1.1-

4 - Number, space, negative sign; for example, 1.1 -

LeadingZero - indicates if leading zeros should be used in decimal fields.  If the flag is missing, the field "Display leading zeros" from "Regional and

Language Options" is using. The valid values are 0, 1

Other known operators for strings are:

len (unary operator) retrieves the number of characters in the string. For instance, the len("Mihai") returns 5.

lower (unary operator) returns a string expression in lowercase letters. For instance, the lower("MIHAI") returns "mihai"

upper (unary operator) returns a string expression in uppercase letters. For instance, the upper("mihai") returns "MIHAI"

proper (unary operator) returns from a character expression a string capitalized as appropriate for proper names. For instance, the proper("mihai")
returns "Mihai"

ltrim (unary operator) removes spaces on the left side of a string. For instance, the ltrim(" mihai") returns "mihai"

rtrim (unary operator) removes spaces on the right side of a string. For instance, the rtrim("mihai ") returns "mihai"

trim (unary operator) removes spaces on both sides of a string. For instance, the trim(" mihai ") returns "mihai"

reverse (unary operator) reverses the order of the characters in the string a. For instance, the reverse("Mihai") returns "iahiM"

startwith (binary operator) specifies whether a string starts with specified string ( 0 if not found, -1 if found ). For instance "Mihai" startwith "Mi"
returns -1

endwith (binary operator) specifies whether a string ends with specified string ( 0 if not found, -1 if found ). For instance "Mihai" endwith "ai" returns -1

contains (binary operator) specifies whether a string contains another specified string ( 0 if not found, -1 if found ). For instance "Mihai" contains "ha"
returns -1

left (binary operator) retrieves the left part of the string. For instance "Mihai" left 2 returns "Mi".

right (binary operator) retrieves the right part of the string. For instance "Mihai" right 2 returns "ai"

a lfind b (binary operator) The a lfind b (binary operator) searches the first occurrence of the string b within string a, and returns -1 if not found, or the

position of the result ( zero-index ). For instance "ABCABC" lfind "C" returns 2

a rfind b (binary operator)  The a rfind b (binary operator) searches the last occurrence of the string b within string a, and returns -1 if not found, or the

position of the result ( zero-index ). For instance "ABCABC" rfind "C" returns 5.

a mid b (binary operator) retrieves the middle part of the string a starting from b ( 1 means first position, and so on ). For instance "Mihai" mid 2 returns

"ihai"

a count b (binary operator) retrieves the number of occurrences of the b in a. For instance "Mihai" count "i" returns 2.



a replace b with c (double binary operator) replaces in a the b with c, and gets the result. For instance, the "Mihai" replace "i" with "" returns "Mha"

string, as it replaces all "i" with nothing.

a split b, splits the a using the separator b, and returns an array. For instance, the weekday(value) array 'Sun Mon Thu Wed Thu Fri Sat' split ' ' gets the

weekday as string. This operator can be used with the array. 

Other known operators for dates are:

time (unary operator) retrieves the time of the date in string format, as specified in the control's panel. For instance, the time(#1/1/2001 13:00#) returns

"1:00:00 PM"

timeF (unary operator) retrieves the time of the date in string format, as "HH:MM:SS". For instance, the timeF(#1/1/2001 13:00#) returns "13:00:00"

shortdate (unary operator) formats a date as a date string using the short date format, as specified in the control's panel. For instance, the

shortdate(#1/1/2001 13:00#) returns "1/1/2001"

shortdateF (unary operator) formats a date as a date string using the "MM/DD/YYYY" format. For instance, the shortdateF(#1/1/2001 13:00#) returns

"01/01/2001"

dateF (unary operator) converts the date expression to a string expression in "MM/DD/YYYY HH:MM:SS" format. For instance, the dateF(#01/01/2001
14:00:00#) returns #01/01/2001 14:00:00#

longdate (unary operator) formats a date as a date string using the long date format, as specified in the control's panel. For instance, the

longdate(#1/1/2001 13:00#) returns "Monday, January 01, 2001"

year (unary operator) retrieves the year of the date (100,...,9999). For instance, the year(#12/31/1971 13:14:15#) returns 1971

month (unary operator) retrieves the month of the date ( 1, 2,...,12 ). For instance, the month(#12/31/1971 13:14:15#) returns 12.

day (unary operator) retrieves the day of the date ( 1, 2,...,31 ). For instance, the day(#12/31/1971 13:14:15#) returns 31

yearday (unary operator) retrieves the number of the day in the year, or the days since January 1st ( 0, 1,...,365 ). For instance, the yearday(#12/31/1971
13:14:15#) returns 365

weekday (unary operator) retrieves the number of days since Sunday ( 0 - Sunday, 1 - Monday,..., 6 - Saturday ). For instance, the weekday(#12/31/1971
13:14:15#) returns 5.

hour (unary operator) retrieves the hour of the date ( 0, 1, ..., 23 ). For instance, the hour(#12/31/1971 13:14:15#) returns 13

min (unary operator) retrieves the minute of the date ( 0, 1, ..., 59 ). For instance, the min(#12/31/1971 13:14:15#) returns 14

sec (unary operator) retrieves the second of the date ( 0, 1, ..., 59 ). For instance, the sec(#12/31/1971 13:14:15#) returns 15

The expression supports also immediate if ( similar with iif in visual basic, or ? : in C++ ) ie cond ? value_true : value_false, which means that once that cond
is true the value_true is used, else the value_false is used. Also, it supports variables, up to 10 from 0 to 9. For instance, 0:="Abc" means that in the variable 0
is "Abc", and =:0 means retrieves the value of the variable 0. For instance, the "len(%0) ? ( 0:=(%1+%2) ? currency(=:0) else `̀ ) : `̀" gets the sum between
second and third column in currency format if it is not zero, and only if the first column is not empty. As you can see you can use the variables to avoid
computing several times the same thing ( in this case the sum %1 and %2 .

Samples:

�. "1", highlights all cells or items. Use this form, when you need to highlight all cells or items in the column or control. 

�. "%0 >= 0", highlights the cells or items, when the cells in the first column have the value greater or equal with zero

�. "%0 = 1 and %1 = 0", highlights the cells or items, when the cells in the first column have the value equal with 0, and the cells in the second column

have the value equal with 0 

�. "%0+%1>%2", highlights the cells or the items, when the sum between first two columns is greater than the value in the third column

�. "%0+%1 > %2+%3", highlights the cells or items, when the sum between first two columns is greater than the sum between third and forth column.

�. "%0+%1 >= 0 and (%2+%3)/2 < %4-5", highlights the cells or the items, when the sum between first two columns is greater than 0 and the half of the

sum between third and forth columns is less than fifth column minus 5.

�. "%0 startwith 'A'" specifies the cells that starts with A

�. "%0 endwith 'Bc'" specifies the cells that ends with Bc

�. "%0 contains 'aBc'" specifies the cells that contains the aBc string

��. "lower(%0) contains 'abc'" specifies the cells that contains the abc, AbC, ABC, and so on

��. "upper(%0)'" retrieves the uppercase string

��. "len(%0)>0'" specifies the not blanks cells

��. "len %0 = 0'" specifies the blanks cells

 2. Valid Formats

The following are valid expressions that can be used in the "Formats" column of the conditional formats.

Bold property. Bolds the cell or items
Italic property. Indicates whether the cells or items should appear in italic.
StrikeOut property. Indicates whether the cells or items should appear in strikeout.
Underline property. Underlines the cells or items
Font property. Changes the font for cells or items.
BackColor property. Changes the background color for cells or items, supports skins as well.
ForeColor property. Changes the foreground color for cells or items.
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Web Named Colors (node 2360)

I've written a simple excel spreadsheet that generates IQ NamedColors

(in the wacky reversed VB hex code format) for the HTML/CSS/X11 Color Set

(142 colors total).

It's attached with instructions, but to use the colors you can just copy and paste

the following line as your IQ Named Colors as described in Item Formatting.

IndianRed|&H5C5CCD|LightCoral|&H8080F0|Salmon|&H7280FA|DarkSalmon|&H7A96E9|LightSalmon|&H7AA0FF|Crimson|&H3C14DC|Red|&H0000FF| FireBrick|&H2222B2|DarkRed|&H00008B|Pink|&HCBC0FF|LightP

The list of colors can be found at http://en.wikipedia.org/wiki/Web_colors.

If you have any questions, post them in colors, colors, colors.
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Fields

In InfoQube, essentially ALL information is stored in fields, in either System fields, or User-Defined fields.

There are 4 field types:

Text

Yes / No

Number

Date

A field is identified by its ID (auto-generated unique number) and its name (which must also be unique).

Fields have many properties and these can be viewed / modified using the Field Properties Dialog

An item can have any number of field values

Important System fields are:

Item : contains the item text

IDItem : item ID (auto-generated unique number)

ItemHTML : contains the Doc pane content

ItemColor : Background color of the item, shown in most UIs, such as grids, Calendar, Surface, etc

Appointments : Date of event for items shown in the Calendar

Inbox : Items added to your IQBase often have this field checked and will show in the Inbox grid

Done : Date an item is marked as done. Use Item > Mark as Done

DueDate : Date an item should be completed by
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Field Management Dialog

Field Properties Dialog

Fields are at the core of InfoQube's information management tools. it allows users to add additional information to items.

https://infoqubeim.com/219
http://en.wikipedia.org/wiki/Web_colors
https://infoqubeim.com/2361
https://infoqubeim.com/drupal5/index.php/pierre
https://infoqubeim.com/drupal5/files/htmlColors.2.zip
https://infoqubeim.com/drupal5/files/htmlColors_0.zip
https://infoqubeim.com/drupal5/files/htmlColors.zip
https://infoqubeim.com/1068
https://infoqubeim.com/drupal5/index.php/pierre


The dialog is divided into 4 sections:

1- Top: Filter button and text box. Enter text to field list. Shortcuts are Ctrl+F and Ctrl+G

2- Left: Shows the list of defined fields with the following columns:

Field ID: ID below 200 are system fields and cannot be deleted

Name: Field name. Must be unique

Field Type: One of 4 types. Type can be changed only if no values are assigned

# items: number of items that have values for each field

Code: shows fields that have associated code

System fields are shown with grey background

Right-click show a Context menu with the following commands:

�. Add as a Grid Column: Show the selected field(s) in the current grid

�. Show Field Values: Opens the Scratch grid showing a flat list of all items with a value for the current field

�. Copy Field Values...: Opens a dialog to copy values from one field to another (i.e. merge):

Clicking Copy Values will analyse both fields and show a dialog of choice of actions:



�. Copy Field: Copies the selected field(s) to the clipboard

�. Paste Field: Pastes the field(s) in the clipboard. Creates new field(s). If paste is done in the same IQBase, a dialog will give the option to also copy

the field values to the new field(s)

3- Right: Shows all field properties, arranged in 5 sections:

�. General

�. Editor

�. Equations

�. Conditional Formats

�. Options

4- Bottom: List of command buttons:

Drop-down menu to:

Copy field values

Recalculate field dependencies

Export all field equations to a text file. Great to understand and summarize field relations

New: Adds a new field

Undo: Restore the field to the last saved state

Save: Save the current field definition

Auto Save: If checked, changes are saved automatically. System fields never Auto-save. Click Save to save changes

Create / Modified date and times

Close dialog

n.b. The dialog is not modal, so it can be left open while working

1. General

Field name: 50 chrs max. Can include any combination of letters, numbers, spaces, and special characters except :  ! * ? . ,  ̀" [ ] | ~

Description: Text description, 255 chrs max

Caption in grids. Grid column header text for this field. In a grid, can also be set with Column > Column Header > Caption (see 4. Grid Columns and

Column Sets)

Caption in Properties. In the Properties pane, caption can also be set using the context menu (see 6. Properties Pane)

Type: One of:

Date: 1 additional setting is visible for dates:

Format: Enter a specific format or select one of the built-in ones. See Hints section below

Number: 2 additional settings are visible for numbers:

Check Auto to get an auto-increment number. If you manually change the field value and that value already exists, the change is cancelled

and a warning is shown as a pop-up notification

Format: Enter a specific format or select one of the built-in ones. e.g. 0 to format a number without decimals, 0.00 for 2 digits after the

decimal point. See Hints section below

Text

Yes/No

Field type can be changed if it has no field values.

If the field already has some values, you can create a new field of the desired type and copy values from one field to another

Properties:

Read only: Grid and Properties pane editor is disabled, so values cannot be modified. Equations can update the values however

Wrap text in Properties pane: Causes all lines of the field to be shown in the Properties Pane.

To show multiple lines in a grid column use the wordwrap option for the column itself (see 6. Column Menu)

Hyperlink: If checked, allows for single-click actions in grids and the properties pane (files, web shortcuts, email)

Parse if starts with '=': If checked, text field values that start with = will treat it as an equation. If unchecked, parsing can be triggered in the

Properties pane > Parse Equation

https://infoqubeim.com/3167
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In Calendar by default: For date fields, creates an event when a value is added to this field

Hide in Info. Pane: Show/hide in the item field-value in the Filled Fields section of the properties pane

Hide in Available fields: Show/hide in the item field-value in the Available Fields section of the properties pane

is 'Done' field: A Date or a yes/no field can be set to be used as the done field (used in Item>Mark as done [Ctrl + M] and in the DateFilter toolbar.

The Done field (date) is the default field, but another date field or a Yes/No field can be used if desired

Include in new grids: Automatically include this field in new grids (as a grid column)

Field Color: Background color when shown in the Properties pane and as a column in grids 

Default value: Value to use when InfoQube needs to automatically assign a value to a field. Double-click or Alt-click in a grid cell will also assign

this value

ex: Now: today's date and time, int(Now): today's date. The default value can be a number or text or an equation.

Alignment: Sets text alignment in grids and the Properties pane

Auto-Search: When auto-search is checked in a grid, determines if 'Start with' or 'Contains' is used when users start typing (and not editing)

2. Editor

See Field Management Dialog - Editor

3. Equations

See Field Management Dialog - Equations

4. Conditional Formats

See Conditional Formatting

5. Options

Sets some additional field options:

<CAPS>: Displays all text as upper case

<Source>SQLSelectString</Source>: Creates a custom field using SQL. See Smart Fields

<Separator>CR</Separator>: For the ItemValues field, specifies how to separate entries. Use CR to have each entry on a new line

<Prefix>--</Prefix>: For the ItemValues field, specifies the prefix before each entry

Hints:

The dialog is non modal. This means you can leave it open and return to the main UI. It can be minimized too

You can drag-drop fields from this dialog to any grid, to add the field as a column

Formats: The full list of formatting codes can be found here: https://docs.microsoft.com/en-us/office/vba/language/reference/user-interface-help/format-function-visual-
basic-for-applications
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Field Editor

Field-values are typically displayed in grids and in the Properties pane. To make changes, customizable editors are possible, depending on field type:

Yes / No fields show a check box by default. To change the images displayed for both checked and un-checked states, modify the CheckOn.ico and CheckOff.ico files (located in the AppFiles folder)

Text fields show a text box with or without a mask. A pop-up list of suggested values is also possible (single or multi-select types)

Number fields show a text box with up/down spin buttons. A pop-up list of suggested values is also possible

Date fields show a text box with a dropdown button to show a mini-calendar and options to show the item in the Calendar

Choosing the Editor Type

For Text and Number field types, the editor type can chosen for each field. The following editor types are available:

�. Text box

�. Text box with mask

�. Fixed list pop-up

�. List of items pop-up

�. Auto-list of values

�. Advanced Mode

In the Field Properties dialog, select the field in the field list and open the Editor section:
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Multi-Select pop-up list

Of these editor types, 2 support multiple selections:

�. List of items pop-up

�. Auto-list of values

See Multi-select Pop-up Lists for details

1. Text box

This is the default field editor. It is a standard text box supporting cut / copy / paste / select all / undo (through menu commands, right-click context menus and keyboard shortcuts)

2. Text box with mask

For text fields, it is possible to use of a mask:

The input mask limits the amount and type of information that can be entered in a field.

For example, a telephone field could contain (###) ###-####  as the input mask

This field would then show (___) ___-____   and would only allow number entry

Here's the list of all rules and masking characters:

# (Digit), Masks a digit character. [0-9]

x (Hexa Lower), Masks a lower hexa character. [0-9],[a-f]

X (Hexa Upper), Masks a upper hexa character. [0-9],[A-F]

A (AlphaNumeric), Masks a letter or a digit. [0-9], [a-z], [A-Z]

? (Alphabetic), Masks a letter. [a-z],[A-Z]

< (Alphabetic Lower), Masks a lower letter. [a-z]

> (Alphabetic Upper), Masks an upper letter. [A-Z]

* (Any), Mask any combination of characters.

\ (Literal Escape), Displays any masking characters. The following combinations are valid: \#,\x,\X,\A,\?,\<,\>,\\,\{,\[

{nMin,nMax} (Range), Masks a number in a range. The nMin and nMax values should be numbers. For instance the mask {0,255} will mask any number between 0 and 255.

[...] (Alternative), Masks any characters that are contained by brackets []. For instance, the [abcA-C] mask any character: a,b,c,A,B,C

3. Fixed list pop-up

The fixed list pop-up is a simple pop-up editor that allows selection of a single value from a list (multi-select not possible)

Enter the list of  suggested values, separated by the vertical bar ( | ). To edit large lists, double-click or press F2 to open the pop-up editor (which can be resized)

The advantage of this editor w.r.t. other pop-up types is faster to select from the list, in particular if "Entry must be in list" is checked

Gives:
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4. List of items pop-up

The pop-up list comes from the values in the IQBase. It can be from a field used for just that (text, date, number) or a more generic field (i.e. Item, notes, etc) filtered.

When selecting this option, you'll see:

You have 2 options for this list. Of the two options, #2 is easier:

�. Option 1: Field dedicated to this popup:

�. Create a new Text field. ex ActionOnList

�. Add values (one easy way is to double-click on the new field in the properties pane

�. In the editor of the field which which will show the popup (e.g. ActionOn), select this new field from the list (e.g. ActionOnList)

�. Option 2: Filtered generic field:

�. The easiest way to do this is to create a new grid, such as ActionOnList and simply enter the list in the new grid.

�. In the editor of the field which which will show the popup (e.g. ActionOn), select "Item" for the field and "ActionOnList" for the filter

Either way will result in a pop-up list :

5. Auto-list of values

This pop-up list type is the easiest to setup. It shows an standard edit box and a button to bring up the list of values previously entered in this field:



The "A" button (A stands for "All", button is at the bottom-left) toggles from 2 possible lists:

List of all field values in the database (i.e. all distinct values for this field)

List of all field values of items in the current grid

6. Advanced Mode

Through SQL queries, advanced pop-up editors can be created. Examples are:

�. Multi-column pop-up lists

�. List from another database (IQBase, Access, etc)

6.1 Multi-column pop-up lists

Using SQL queries, you can have a pop-up list showing more than one column. If "Save all listed fields" is checked (see image in section 3. above), the pop-up list can save all columns. For example, if you want to

see both the contact name and telephone number:

�. Select SQL query (advanced) for the edit type

�. In Pop-up list, enter:

Select Item as MyContacts, Tel from AdrsBook ORDER BY left(Item,100) 
�. Check "Save all listed fields"
�. Click Save and Close

�. The pop-up list will now look as such:

�. Selecting an item in this list will assign values to both fields (MyContacts and Tel)

�. To know what values to copy in which field, the pop-up column name must match the column name of the grid (in this case, the column names are MyContact and Tel)

�. Notice that to sort on a text field, one must add a function to retrieve a portion of the text field ( < 255 chrs) (see ORDER BY clause above)

6.2 List from another database

The SELECT clause can be quite complex and data can come from any other ODBC-enabled database (IQBase, MS Access, SQL Server, MySQL, SQLite, etc).

The only requirements for this multiple assignment is that the resulting column names (as seen in the pop-up list) be the same as field names in your IQBase.

A forum thread discusses how to use pop-up lists: [How do I] Pop Up Lists
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Equations, Rules, and Inheritance

InfoQube supports equations for computing the values of fields. Equations can pull values from other fields on the same item, or from parents and children

(column inheritance and equations).

There are two types of row equations and two types of column equations:

https://infoqubeim.com/index.php?q=taxonomy/term/109
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Row Equation: Updates the current field’s value when other field values change

Auto-assignment Rule (or Push Equations): Updates other fields when the current field is changed

Column Inheritance: Children inherit the parent field value

Column Equation: Parent field value is calculated from the children

Equations can use built-in functions and user-defined functions (see 7. Visual Basic Editor for details)

1. Row Equations

Equations compute a value from the values of other fields, when used in an equation we call these field arguments. As an example, the following equation is

equal to the value of the SubTotal field times 0.08.

0.08 * [SubTotal]

In this example SubTotal is considered a field argument. Anytime that field’s value is changed on an item, this equations value will change as well.

Depending on the type of equation that will result in another field’s value being updated. You use a field argument by just listing the field name in an

equation inside square brackets (note that the square brackets are actually optional, but recommended in case you field name matches a function name or

reserved word).

If you are familiar with Excel the idea is the same, you can write an equation in one cell that depends on other cell arguments. When those cells are changed,

then the first cell’s value is updated. One difference though is that equations only need to be defined once at the field level, then they will apply for that field

for all items (without having to copy the same equation to every row like you do in Excel).

Another big difference is that equations only update field values, which means you can manually change them to something else if you like (if the equation

fires again you will lose the change though).

Equations can work with all the field types (e.g. text, dates, numbers and yes/no), and can use any operator/function that Microsoft VBScript supports. You

can also define your own User Defined Functions to use in your equations as described below.

Some other things to keep in mind about equations:

All types of values are supported (e.g. text, dates, numbers and yes/no).

Fields can be made read-only (using the Field Management Dialog), which means the only way to set their value is through equations (e.g. a "Total"

field)

A Row Equation updates the current field’s value when other field values change. It’s the one that is most similar to what you see in Excel.

Let’s start with an example. The following image shows the Equations section of the Field Management Dialog for the field Taxes. The Taxes field is in the

Sample data file if you want to follow along.

In this example, the current field Taxes will be set to 0.08 times the value of the field argument SubTotal. This Row Equations will apply to the Taxes field for all

items.

If you update the SubTotal field of any item, then the Taxes field will be updated automatically using the equation.

Another difference from Excel is that Row Equations can be circular.

You could have two Row Equations like we show below, one on the StartDate field and one on the EndDate field. If you manually edit the EndDate then the

StartDate gets updated. If you manually edit the StartDate then the EndDate gets updated.

StartDate’s Row Equation: =[EndDate] - [Duration]

https://infoqubeim.com/3965
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EndDate’s Row Equation:  =[StartDate] + [Duration]

Some other things to keep in mind about Row Equations:

Row Equations can cascade. So if field X has a Row Equation that depends on Y, and Y has an equation that depends on Z (X <- Y <- Z). Then editing Z

will update Y which will update X.

Equations cannot update the original field you edited though. So if field X has a Row Equation that depends on Y, and Y has an equation that depends

on X (X <- Y <- X). Then editing X will update Y, but your original edit to X will not be overwritten.

Here's another example from the default New IQBase (with sample data)

Duration field is a number field.

It's row equation reads:

WorkTime([StartDate], [EndDate], 8) - ( [NonBillable] )

to figure out a period of time you need to use the WorkTime(X, Y) equation, where X & Y are date fields (X is the beginning of the time period)

The number 8 allocates eight hours per day when appropriate - you can change this number as you wish -  if not included, the day is treated as 24

hours.

In this example of the Duration field, we are working towards calculating a billable time period so we subtract the field NonBillable (also a number

field) at the end of the equation.

Note that once the Duration field has content, it will stay the same unless modified manually. Changing the StartDate will cause the EndDate to

change - Duration will remain the same. Likewise adding a number to the NonBillable field will cause the EndDate to change - so again, Duration will

remain the same. For more info about the way this can work see this post Duration field ~ some queries

Re the Autoupdate option: it's only important to tick if the value of the field would change with each passing day (i.e. current date is a parameter in the

calculation). See also next paragraph.

Recalculating

Instead of waiting for a field argument to change, you can force a Row Equation to recalculate. You can do this by selecting the field and pressing Shift-F9.

This will cause the Row Equation for that field to immediately execute.

You can also recalculate a field for all items by clicking the recalculate button next to the Row Equation’s text field in the Field Management Dialog.

You also have the option to have a field’s Row Equation recalculate for all items daily. If you check the Auto-update checkbox  above the Row Equation’s text

field, then InfoQube will recalculate the field for all items on each change of day (at midnight or the next time you start InfoQube). Note, Auto-updating can

be a lengthy process, so use it only when required.

https://infoqubeim.com/drupal5/index.php?q=node/2177#comment-9325


NOTE, when recalculating Row Equations will only fire if they have a field argument that has a value. If none of the field arguments have a value then the Row

Equation will not fire. That means Row Equations with no field arguments will never fire (e.g. =Now()).

2. Auto-assignment Rules

While Row Equations update the current field when other fields change, Auto-assignment Rules actually do the reverse. They update other fields (called

target fields) when the current field is changed. Their syntax is:

<Flags>:<TargetField> = <Equation>

Because Auto-assignment Rules update other fields, you have to list what target field to update. You also need to provide a flag that indicates when that field

should be updated. For example, you may only want to update it when the current field is first added, but not when it’s modified. There are three flags you

can use (separately or together):

A:  Update target field when the current field is added (initially no value in the current field)

M:  Update target field when the current field is modified (initially there is a value in the current field)

E:  Update target field when the current field is erased (the current field had a value and you deleted it)

(Flag D: for 'Delete' is synonymous to E:)

Z or anything else: Use this flag to disable a rule. Only A, M, E, D will trigger, all other flags will not trigger

You can have as many auto-assign rules as you wish separated by vertical bars (or a new line), they'll be executed in the sequence that they are entered.

Here is a simple example from the sample file on the field Archived. When you first add a value to the Archived field, that item’s Notes field will be set to

“Archived”. If you later on erase the Archive field for that item, then it will have its Notes field changed to “not archived”.

Some other things to keep in mind about Auto-assignment Rules:

They are actually more efficient than Pull equations, since it is the current field that triggers the equation. Plus they allow many equations to be

triggered by a single field change.

Equations can cascade. So if A has a rule that updates B, and B has a rule that updates C (A -> B -> C); then editing A will update B which will update C.

Rules cannot change the original field you edited though. So if A has rule that updates B, and B has a rule that updates A (A -> B -> A); then editing A

will update B, but your original edit to A will not be overwritten.

Auto-assign rules can also add / remove tags:

Add a Tag: Use #TagName or #TagName=-1 or #TagName=1
Remove a Tag: Use #TagName= or #TagName=0

See Examples section below !

3. Column Inheritance

New children inherit the parent's value

Any changes to the parent item updates children (that have the same value as the parent)

Inherited value is not read-only, so it can be changed. If the child value is different than the parent, it will no longer inherit the parent's value

To use Inheritance:

Set the Inheritance button ON

(Column inheritance and equation (below) are mutually exclusive)

Can delete on item move: When a sub-item is moved away from a parent, from which it inherited a field value, should the inherited value be deleted or

not

4. Column Equations

Column Equations work with the outlining capabilities of InfoQube. Say you are a consultant and need to write a proposal. You can use InfoQube to describe

the project and break it down into tasks and sub-tasks, etc. If you set-up a Duration column to perform Column level sum, the project duration and task

duration will be automatically calculated from the sub-tasks. No need to set-up complicated equations to total each group of cells, that bringing that up to

the next level, etc as you would need to do in Excel.

The equation is defined once at the field level:

Parent = SUM (children)



That's it! Make any changes to a sub-sub-task. The project duration is automatically updated. Same for project cost. A great time saver

Hierarchy Equations can also work in reverse - children's field values can be computed based on their parent's field value.

Hierarchy Equations use User Defined Functions (see below for more information on Functions) to define how to compute their values. The User Defined

Function takes as its argument an array of the sub-item field values and returns the computed value for the parent item's field. For example:

Function Sum(x) ' Calculates the sum of the array x

dim d, i
d=ubound(x)
for i=0 to d

Sum=Sum+NZ(x(i))
Next

End Function

The following basic functions are already included:

Sum

Max

Min

Avg

Hierarchy Equations with Parameters

It is possible to have Hierarchy equations based on many parameters. The syntax is: Parent = YourVBScriptFunction(Field1, Field2, ...

Typically, this can be used to have conditional hierarchy sums (sums of only some of the children).  For example if the hierarchy equation is: Parent =

mysum(Billable, Children)  where mySum is a VBScript function:

Function mySum(IncludeIt, x)  ' Calculates the sum of the array x if IncludeIt is true 
 dim d, i, OK 
 ok=false 
 d=ubound(x) 
 for i=0 to d 
  if IncludeIt(i)=true then  
   mySum = mySum+NZ(x(i)) 
   ok=true 
  end if 
 next 
 if ok=false then mysum=null 
end Function

In this case, the parent will take the sum of all children that have the field Billable checked.

5. Getting Row and Hierarchy Equations to work together

When a cell value (i.e. an item field value) is governed by both a row and a hierarchy equation, the value will be:

�. The Hierarchy equation returned value if not null

�. The Row equation otherwise

6. User-defined Functions

See 7. Visual Basic Editor for details

7. Examples

Row Equation Example 1

 Here is an example of using Auto-update and using a User Defined Field. For the Urgency field below, is required, is the Urgency field, as the CalcUrgency

function uses the current date (see "now" below) to get an Urgency number (>0 is late):

https://infoqubeim.com/3965


Function CalcUrgency(Due, Duration, PDone, Done)   ' calculates an Urgency figure for tasks >0=late or will be
late based on Duration and PercentDone 
  if isnull(Done) and not isnull( Due ) then 
     CalcUrgency = int( int(now) - int(cdate( nz( due ) )) + (nz(Duration) * (100-nz(PDone))/100 * 7/5) ) 
     if CalcUrgency<-60 then CalcUrgency=null 
  else 
     CalcUrgency = null 
  end if 
End Function

Auto-assignment Example 1

Here is an example that calculates the color when a field is added or edited and clears the ItemColor when the field is erased:

AM: ItemColor=CalcColor ([DurationHr] - [BudgetHrs]) | E: [ItemColor]=

Auto-assignment Example 2

Here's a rule, written in the "Auto-Assign Rules" of the item field :

AM:Food=HasKeyword([Item],"Breakfast",-1)|E:Food=

This first part of the rule will check the Food target field if the field Item has the keyword "Breakfast". For yes/no fields -1 means enabled and 0 means empty.

The second part means that when the item field gets emptied, the food field is unchecked.

Auto-assignment Example 3

You want the Today field to turn on automatically when the Urgency field gets to zero. If Urgency exceeds zero (you are late!), the Today field is not changed.

This uses the iif statement (more info):

M:Today=iif([Urgency]<0,0,iif([Urgency]=0,-1,[Today]))

Auto-assignment Example 4

If an item is marked pending, then the {pndg} wikitag is added automatically:

A:WikiTag=AddKeyWord([WikiTag],"{pndg}") | E:WikiTag=RemoveKeyWord([WikiTag],"{pndg}")

Auto-assignment Example 5

Strike an item when marked done. For the Done field:

AM:[ItemFont]=SetFontAttrib([ItemFont],"S",-1) | D:[ItemFont]=SetFontAttrib([ItemFont],"S",0)

Last Name and First Name Auto-fill Example

How to automatically fill the item field with the "last name" and "first name" of a contact ?

7. Errata/References

The following are outstanding questions or issues with this page - feel free to fix if you know the answer!

Hierarchy Equations

Automatic-recalculation - Not implemented yet? (see "downwards" column equations)

Children equations are not implemented yet (see "downwards" column equations), but you can use Inheritance (see -- link to nonexistent node ID

1072 --)

None - not sure what this does, maybe just turns it off? (see "downwards" column equations)

Using field arguments, and possibly add example at end of conditional column equations (/drupal5/index.php?q=node/2070#comment-9119)

The  "no values" as 0 option needs to be explained The null=0 option in the field management dialog should be explained more clearly

What is the cascade rules between auto-assign and row equations. What order are they fired in? [major] Problem with column/row equation -- please

read-on [major] Problem with column/row equation -- please read-on

The ability to use equations to set property values when are row equations run?

You can export all of your equations as a text file by clicking in the upper left corner of the Field Properties dialog and choosing "Export All Equations to

a text file" (added 0.9.25W3)

All fields referenced in equations need to be enclosed by square brackets ( i.e. [ YourField] )
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http://msdn.microsoft.com/en-us/library/aa164019%28office.10%29.aspx#odc_tentipsvba_topic9
https://infoqubeim.com/drupal5/index.php?q=node/1672
https://infoqubeim.com/1795
https://infoqubeim.com/1795
https://infoqubeim.com/1795
https://infoqubeim.com/drupal5/index.php?q=node/2070#comment-9119
https://infoqubeim.com/1394
https://infoqubeim.com/1587
https://infoqubeim.com/1587
https://infoqubeim.com/2070
https://infoqubeim.com/drupal5/index.php/pierre


104 views

Multi-select Pop-up Lists

Multi-select Pop-up Lists

Multi-Select Pop-up Lists

When categorizing information, it is often useful to assign multiple properties to items. InfoQube provides many ways to do this, namely:

Placing the item under more than one parent, the parent being a category description

Assigning many yes/no field values. Each field representing a property

Assigning tags. Tags support inheritance (in fact, multiple inheritance paths) so a single assigned tag can provide multiple grouping buckets

Assigning dates. Dates can be grouped into categories (day, week, month, year)

Assigning a value in a text field. So if the field name is Color for example, users could enter Red, Green or Blue to describe the item. To assign more than

one value, additional text fields can be used.

In addition, it is possible to easily assign multiple text values in single text field.

The WikiTag field (now depreciated in favor of the new Tagging system) is a good example of this. Details here.

 To do this, in the field properties Editor section, simply check the Multi-Select check box:

The Multi-Select Pop-up list is enabled for two types of field editors:

�. Auto-list of values

�. List of items pop-up

1. Auto-list of values

Auto-lists, as the name implies, is generated automatically, based on previously entered field-values. To set up multi-select, follow the following steps:

�. Click on the settings button ( ... )

�. Specify how to keywords are defined. Users are free to use any of these methods:

�. Enclosed (i.e. { }, [ ], - -, | |)

�. Hashtag (i.e. Twitter-like #IQ #Cool #SuperPIM #EccoPro)

�. Delimited (i.e. CamelCase, comma separated, , | )

�. Sync matching Fields: If checked, Y/N fields with names the same as the value will sync (i.e. will check / uncheck as values are entered / removed from

the list)

�. Click OK

2. List of items pop-up

When Auto-list is not the best option, the list can come from existing items. To create such a list, first create a new grid:

�. View > Grids > New Grid

�. In the Create grid dialog, enter a name, such as "ListTags"

�. Click OK, the new grid will open

�. Enter the list items, one per line
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Once the list has been created, create a new text field, such as "Categories" or "Types"

�. In Field Management, click New

�. Enter the name and set the data type to Text

�. In the Editor section, set the type to List of items pop-up. The dialog will update to show this:

�. Set the first combo box to Item (this is the field that contains the text values)

�. Set the second combo box to ListTags (this is the field that was created when the above grid was created and identifies list items)

�. In a similar matter as for Auto-list values above, check Multi-Select and specify how to enclose and delimit values (see section 1.0 above)

3. Entering multiple values

In the relevant grid, add the created field or use the Properties pane

When the selected cell is under the proper column, press F2 to enter edit

You can manually enter values, or

Press F2 again to display the multi-select dropdown

Use the arrow keys to select a type and press enter to toggle the check box

For long list, you can start typing to find types. Press F3 to find the next match. Enter to toggle the check box

When done, either click OK or press F2 again

In the above example, item "Meet with customer..." was assigned two text values, CRM and ProjectMgr. These will be shown in a single cell under the

"Tags" column (not to be confused with the new Tag system column)

4. Using Multi-Select Pop-up Lists

IQ provides many ways to use these multi-valued text fields, for example:

Create a grid to show all entries with a specific values

Ctrl+G to filter the current grid for specific text value(s)

Ctrl+F3 to auto-search for a specific text value

Ctrl+F to search and collect items with specific text value(s)

5. Convert to Tags

Multi-select pop-up lists can be used as tags (e.g. the above sample). The stock WIKITag field is a good example.

The new IQ Tagging system is generally far superior to what can be done with a multi-select pop-up list.

There is therefore a need to convert from then "old" Wiki-style tagging system to the "new" one.

To convert values entered in such a text field to tags:

https://infoqubeim.com/drupal5/node/4328


�. Click on the Convert to Tags button:

�. Select 1- Yes to convert

�. Tag names cannot contain the following characters: , ; # [ ] tab and spaces

An input box will be shown to select the character to use to replace invalid characters

�. Once converted, a dialog will show the number of new tags created and the number of tags assigned to items

6. Notes

Currently, the Multi-Select check box is visible for Auto-List and List of Items type pop-ups.

It is best not to change the value delimiters after values have been entered, as parsing will most likely fail, and manual editing will be required to

properly format the values

Sync matching Fields works with Y/N fields only, and sync in one direction (multi-select -> Y/N field value). It is possible to also sync in the other

direction using Auto-Assign rules (hint: use the supplied helper VBScript AddKeyword and RemoveKeyword functions)
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 System Fields have special properties, and  have IDs less than 200.

They are shown in with a grey background in the properties pane and in Field Management.

These fields are protected fields. Most (all?) can be renamed.

ID Name Type Comments Reference

1 Item Text text of the item

2 IDItem Number unique numeric ID

3 ItemCreated Date automatic, can edit in the Properties pane

4 ItemOwner Text user that created the item

5 ItemModified Date automatic, can edit in the Properties pane

6 ItemFont Text item font properties, except for colors

7 ItemLocked Binary Locked items can be modified but not erased. Not visible in field management dialog

8

9 ItemHomeID Number Item Home

10 ItemHTML Text Doc pane content

11 FileRef Yes/No item is a file reference

12 FileName Text  If you drag-drop files, FileName and FilePath are filled

13 FilePath Text  If you drag-drop files, FileName and FilePath are filled

14 SearchResults Yes/No Default field used to show the search results

15 URL Text can hold URL of a file or website. Hyperlink

16 WIKITag Text Depreciated. used as tags Info

17 FileFullName Text smart field. Combines FilePath and FileName

18 FileText Text Text content of an indexed file

19 FileTextSize Number

20 ItemHTMLFile Text File shown in the Doc pane

21 ItemHTMLText Text Plain text content of the Doc pane

22 ItemColor Text Background item color

https://infoqubeim.com/drupal5/index.php/pierre
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23 ItemsTagged Number Items that have at least one tag (currently does not work)

24 ItemsMarked N See Marked Items. Not visible in field management dialog.
How does user filter

for 'tagged' items?

25 ItemForeColor Text Item Text color

26 ItemHasHTML Yes/No Smart field that show a checkbox if the item has some content in the Doc pane

27 ItemHTMLHeight Number
During HTML export, the MHT document height cannot be determined;  ItemHTMLHeight allows

you to specify the height to allocate for the MHT document.

28 ItemTextSize Number number of characters in all text fields combined.

29 ItemHTMLTextSize Number number of characters in the Doc pane.

30 ItemHTMLSize Number Doc pane storage size

31 TextFields Text Item's text fields. Useful to search. Not visible in field management dialog.

32 DateFields Date Item's date fields. Useful to search. Not visible in field management dialog.

33 NumberFields Number Item's number fields. Useful to search. Not visible in field management dialog.

34 BinaryFields Binary Item's Y/N fields. Useful to search. Not visible in field management dialog.

35

36

37

38

39 ItemHTMLWordCount Number Word count

40 NbChildren Number Calculated field

41 nbParents Number Calculated field

42 ItemParent Text Text of the item parent (smart field)

43 ItemGParent Text Text of the item grand-parent (smart field)

44

45 System Yes/No Container field. Used to be able to show/hide child fields

46 Tags Yes/No Indicates the item is a Tag. Info

47 TagID Number Unique tag ID

48

49 Notes Text General purpose notes field. Available in the Item Editor

50 Appointments Date Default date field to create events

51 ItemDuration Number Length (in hours) for an event

52 ItemInCalendar  Yes/No Item is shown in the Calendar (smart field)

53

54

55 ItemHTMLStyle Text Style sheet to use for the doc pane content

56 ItemHTMLCaretPos Number Depreciated. Cursor position in the HTML pane

57

58

59

60 AddressBook Yes/No

61

62

63

64

65

66

67

68

69

70 Inbox Yes/No

71 Today Yes/No Following 4 fields are used in GTD type task management

72 Tomorrow Yes/No

73 ThisWeek Yes/No

74 NextWeek Yes/No

75 Reference Yes/No

https://infoqubeim.com/1720
https://infoqubeim.com/403
https://infoqubeim.com/4328


76 Favorites Yes/No Item is a Favorite Info

77 ItemHomeGrid  Text Depreciated

78 OutlineStyles Yes/No Item is an Outline Style Info

79

80 DueDate Date Date the task is due Info

81 Done Date Default "Mark as Done" field. Ctrl+M to mark/unmark item as done

82 TaskList Text Task list a task belongs to Info

83 ToDo Date Date the task was created

84 TaskOrder Number

85  Emails  Yes/No Item is an email. Fields 85-88 are automatically filled when importing emails

86  EmailSender  Text

87  EmailRecipients  Text

88  EmailDate  Date

89

90 TaskActStart Date For Gantt charts, the start date of the task. Info

91 TaskActEnd Date For Gantt charts, the end date of the task

92

93 NextTaskDelay Number For Gantt charts, the delay between a task ending and the start of the next task Info

94 TaskDuration Number For Gantt charts, task Duration in days. Default caption is "Nb Days"

95 Task%Complete Number For Gantt charts Percentage of task that is complete Info

96 TaskEffort Number
In a future release you'll be able to enter the Effort and duration for each of your task and the

Gantt will show you when you're in the red... (i.e. when you'll need to do overtime)

97 TaskID Number Gantt charts, when linking tasks, the fields TaskID and NextTaskID are assigned Info

98 NextTaskID Text

99 TaskActBarColor Text Gantt charts: Item bar color

100 TaskIsSummary Yes/No
Gantt charts: item is a summary item. Start and End dates or the bar are set by the earliest/latest

sub-items dates

101 TaskBarCaption Text Gantt charts, caption to show next to the bar, if empty, will use the item text

120 Surface1 Yes/No Item is on the IQSurface Info

130 ItemTagCount Number
Nb of tags assigned. When shown in a column, press F2 to add/remove tags without opening

the Tags pane. Can be used to trigger actions when tags are added / removed
Info

132 ItemsRelatedCount Number Nb of related items Info

133 ItemsRelated Text List of related items (smart field) Info

145 EnSync Yes/No Sync this item with Evernote Info

146 ENTrash yes/No Item in the Evernote Trash
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Smart fields are used in a number of programs, such as Zoot and EverNote. They are sometimes also called Saved Searches as in Ultra Recall. Smart fields

collect information about items without the user specifically doing it.

Examples of smart fields:

Day: tells the day for a specific date

ItemIsBold: collects all items that are bold

ItemIsRed

ItemHasHTML: tells if an item has HTML content

TasksForJohn

Date of a field with date and times

Date which combines 2 date fields

Smart fields typically take their information from:
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UI related fields (ItemFont, ItemColor, etc)

Other fields that the user entered information

This means that you can extract and collect items using a huge variety of techniques:

Use any text, number, date field and collect items that have specific values (or value range)

Use tags inside the Item field (or another) such as:

If the item is: Talk to {joe} on project {somiro}, then a smart folder/field-type field can collect all items tagged as "Joe" or all items tagged "Somiro"

This gives users a simpler, quicker and "softer" coding method, than regular fields.

Currently, there is no UI specific to creating these smart folder-type fields, but users can easily modify existing examples:

1. Examples of Smart Fields

Let's say you want to have the day of the week for a given date field, so Jan 1st, 2010 would show as Fri (short for Friday)

IQ's sample database has a Day field which is linked to the Date field (a general purpose date field, also in IQ's sample database).

�. Tools > Manage Fields dialog, and select the Day field

�. Look at the Options section. You should see :

<source>SELECT ItemID, Format([Date],"ddd") AS Day FROM ¯qDate;</source>
�. The Format function is a standard VBScript function to format values. "ddd" is the code for the day of the week

What this does is to give the day of the week for a date that's inserted in the Date field.

Of course, you could simply change the Date field name for any other date type field name you'd need the day week for, and it would do it for that field. Just

don't forget to also change the field reference at the end (to q̄YourDateField)

Examples

Year:

Type: Text

Options: <source>SELECT ItemID, Format([Date],"yyyy") AS Year FROM ¯qDate;</source>

Month:

Type: Text

Options: <source>SELECT ItemID, Format([Date],"mmmm") AS Month FROM ¯qDate;</source>
WeekNb:

Type: Number

Options: <source>SELECT ItemID, Format([Date],"ww",2,2) AS WeekNb FROM ¯qDate;</source>
Day:

Type: Text

Options: <source>SELECT ItemID, Format([Date],"ddd") AS Day FROM ¯qDate;</source>

ItemIsBold:

Type: Yes/No

Options: <source>SELECT ItemID, [ItemID]>0 AS ItemIsBold FROM ¯qItemFont WHERE ((InStr([ItemFont],"|B|")
<>0)); </source>

Strikethru

Type: Yes/No

Options: <source>SELECT ItemID, [ItemID]>0 AS Strikethru FROM ¯qItemFont WHERE ((InStr([ItemFont],"|S|")
<>0)); </source>

ProjectSomiro:

Type: Yes/No

Options: <source>SELECT ItemID, [ItemID]>0 AS ProjectSomiro FROM ¯qItem WHERE ((InStr([Item],"{Somiro}")
<>0)); </source>

Dates without times

Say you have a date field which also contains times. An example would be the field used for the Calendar (ApptDate). You may want to hide the time

part. You have at least 2 ways to achieve this:

<format> in the Options section of the field management. Details in -- link to nonexistent node ID 1074 --

You can create a new field, say YourDate, which would be based on the YourDateTime one:

Name: YourDate

Type: Date

Options: <source>SELECT ItemID, int(YourDateTime) as YourDate FROM ¯qYourDateTime; </source>

https://msdn.microsoft.com/en-us/library/d1wf56tt(v=vs.84).aspx
https://infoqubeim.com/index.php?q=taxonomy/term/121
https://infoqubeim.com/index.php?q=taxonomy/term/121
https://infoqubeim.com/index.php?q=taxonomy/term/121
https://infoqubeim.com/index.php?q=taxonomy/term/121


Make sure you substitute all instances of YourDateTime and YourDate with your own field names!

Date that combines 2 date fields

In this case, the user wanted to sort on the created date of an item, but at times, that date was not appropriate for the sort. It was proposed to copy

the created date to another date field and sort on this new field (ItemCreated is read-only).

A more elegant solution uses smart fields. Create a date field to overwrite the ItemCreated value (this example uses the field MyItemCreated)

Create a new field:

Name: MyItemCreated

Type: Date

Create a new field:

Name: SortingDate

Type: Date

Options: <source>SELECT ¯qItemCreated.ItemID, IIf(IsNull([MyItemCreated]),[ItemCreated],
[MyItemCreated]) AS [SortingDate] 
FROM ¯qItemCreated LEFT JOIN ¯qMyItemCreated ON ¯qItemCreated.ItemID =
¯qMyItemCreated.ItemID; </source>

This way, the SortingDate will display the item created date unless the user enter something in MyItemCreated

Text that combine 2 text fields

A user had entered contacts first and last names in separate fields and wanted to see these in a single column (i.e. in a single field). A row equation

could be used and is certainly a good solution.

A smart field could also do the job:

3 text fields: Fname, Lname, ContactName

In the Options section of the field ContactName, enter: SELECT ¯qFname.ItemID, [Fname] & " " & [Lname] AS ContactName
FROM ¯qFname LEFT JOIN ¯qLname ON ¯qFname.ItemID = ¯qLname.ItemID;
n.b. The recommended approach to contact management is to enter both first and last names in the item field (i.e the main text field)

Hyperlink for the URL field

The URL field can contain a URL. Sometimes, one wants to hide the actual link and show some text. To do so:

Create a new field:

Name: URLLink

Type: Text

Options: <source>SELECT IIf([URL] Is Null,"","<A href='" & [URL] & "'>Link</A>") AS URLLink,
¯qURL.ItemID FROM ¯qURL WHERE ((¯qURL.URL) Is Not Null); </source>

The result gives:

Main Parent ID

name: IDMainParent

Type: Number

Options: <Source>SELECT ¯Items.ParentID AS IDMainParent, ¯Items.ID AS ItemID FROM ¯Items;</Source> 
 

Calendar Name

When an item is shown in the Calendar (i.e. it is an event), this field will display the corresponding date field name:

Name: CalendarName

Type: Text

Options: 

<source>SELECT Event.ItemID, ¯Fields.Name AS CalendarName FROM Event INNER JOIN ¯Fields ON Event.FieldID =
¯Fields.ID;</source

Event Description

Events have a number of parameters which are not immediately available as field (to be displayed in a grid column for example). They can nevertheless

be viewed (but not edited) using a smart field. Here we'll show the event description:

Name: EventDescr

Type: Text

Options: 

<source>SELECT ItemID, Body AS EventDescr FROM Event WHERE ((Body<>"") AND (Deleted=False));</source>



Items that are only in the Inbox

This smart field counts the number of Y/N values each item has. This can be used to find items that have only one and the one being Inbox.

Of course grids can have complex sources, but many simply use a Y/N field, so this will work:

Name: ItemYNCount

Type: Number

Properties: Check both Hide in... checkboxes

Options: 

<source>SELECT ItemID, Count(ID) AS ItemYNCount FROM ¯fYesNo GROUP BY ItemID;</source>

In a grid (perhaps a new one), set the source to [ItemYNCount]=1 and [inbox]
Another option is to use the Inbox grid and set the source filter to [ItemYNCount]=1
Best would be to set the grid display mode to Flat list with context parents Off

2. Notes:

It is important that the field name be the same as the AS xxx part of the SQL clause ("AS ItemIsBold" and "AS ProjectSomiro" in the above 2

examples)

You can create grids to show items in these smart fields, use them in filters and in sorting, just like any other field.

If you want, you can hide these specialized field in sections of the properties pane (so it doesn't get too crowded, if you do so, you can still show the

field in forms and in grids). In Field Properties:

Hide in Info. Pane

Hide in Available fields

You don't need to use curly brackets if you don't want to, any delimiter will do, even no delimiter, as this system is entirely into your hands

These smart fields, take no database space at all and is automatically updated

Changes to underlying values (other fields, events, etc) will not update values shown in grids. Press F5 to refresh a grid
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Using Tags

InfoQube has a sophisticated tagging system:

Items can have any number of tags

Tags can easily be added / deleted, in bulk if necessary

Tags are assigned to items by their Tag ID (auto-generated number). This means Tag name can be changed with no impact

Tags can be formatted (bold, italic, back color, text color) and can include icons. This, to easily identify important tags

Tags can be hidden from the tags list (to archive tags without losing the item tags)

Tag can be arranged in hierarchy

Hierarchy is used to provide tag Inheritance (parent tags inherited from child tags)

Tags can be under multiple parent tags (i.e. multiple inheritance paths)

Tags can be used as filters in many UIs, such as Live-Search and all grids

Tags filtering supports logical operators, such as AND, OR, NOT

Item Tags are shown in the Properties pane (under the Tags section)

Item Tags can be shown in grids as a grid column

Any Tag branch can be shown in grids as a grid column

The Tags pane is used to manage and set tags

Field Auto-assign rules can set / unset tags

Unlike most other tagging system, a tag must be explicitly created, this to reduce near duplicate tags, often seen as the main issue with using tags as a

filing system

The Tagging System UI

Tags are present in most, if not all, aspects of InfoQube. Namely:

�. Tags pane: Main UI to view / assign Tags to items

�. Grids: Item Tags shown as columns (all item tags or specific tag branches)

�. Grids: Filtering using Tags

�. Item Tags in the Properties pane and in Forms

�. Tags grid: Advanced tag management including formatting

�. Live-Search: Viewing item Tags and filtering using Tags

https://infoqubeim.com/index.php?q=taxonomy/term/22
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�. Item Editor: Viewing and assigning Tags

�. New Item / Clipper dialog

�. Hyperlink dialog

1. Tags pane

See main page: 7. Tags Pane

The Tags pane is where most of the interaction with Tags is typically done. There a 3 basic functions:

�. Manage the list of Tags (add, edit, delete, rearrange)

�. Assign Tags to items

�. View items having a given Tag (or set of tags)

The Tags pane has a number of additional features:

Search, Sort and Filter Tags, useful as the number of Tags increases

Display options (flat list view, tree view, auto-sort, item count, archived tags)

Tag Inheritance

1.1 Adding / Editing / Deleting / Rearranging Tags

To create a new Tag, press the Insert key (or right-click > Add Tag)

Double-click on the blank area below the tag list can also be used to create tags

To create a child Tag, select the parent Tag and press Ctrl + Insert (or right-click > Add Child Tag)

In both cases, an input box is shown to enter the Tag name

Tag names should be unique but do not need to be (Tags are identified by a unique numerical ID, not by their name)

Tag names cannot contain the following characters: , ; # [ ] tabs and spaces
Tags that have the same name have a  !   icon after the name

Multiple tags can be created (enter a comma separated list of tags in the input box)

To edit tag names, press F2 (or right-click > Edit Tag)

To delete tags, select one or more tags and press the Delete key (or right-click > Delete Tag)

In tree view, tag hierarchy can be modified using cursor keys (up / down / left / right) while holding the Alt key

1.2 Add / Remove Tags to items

The Tags pane is the primary method to add tags to items. To tag items:

Select one or more items. Some UIs allow multiple selections (Grid, Calendar, Surface), other only allow single selection

Find the tag in the Tags pane and toggle the check-mark using the mouse or the space bar key

To help you quickly find tags, the pane supports filtering (see next section) and Search-as-you-type. Press F3 for the next occurrence and Esc to cancel

search

1.3 Using the Filter text box

The top of the Tags pane shows the Filter text box.

Hit Ctrl+F or use the up cursor key to scroll to it

Enter some characters and the tag list will automatically filter

In tree-view, the list maintains the tags hierarchy, so parent tags are shown, even though they do not match the filter

In tree-view, the tags hierarchy will automatically expand to show matching tags.

The pre-filter expand state is saved. So removing filter will show the tree as it was before filtering

Child tags of matching tags are hidden when inheritance is set to None

While focus is still in the Filter text box:

If more than one tag matches the filter, use the down arrow to move focus to a tag and press Space to toggle the tag state

If only one tag matches the filter, press Enter will toggle the tag state
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If no tag matches the filter, press Enter to show the Add Tag dialog

Click the Filter icon, just left of the text box to clear the filter 

1.4 Showing Items

Of course, the whole purpose of a tagging system is to show items that have a given tag or set of tags. That is, out of all the items in the IQBase, show only

those that have certain tags.

Single Tag

In this simple scenario:

�. Select one tag (click on the tag text, not the check-mark)

�. Double-click on a tag or hit Enter (or right-click > Show Items)

�. If a grid that has this tag as a source, it will open, otherwise, the Scratch grid will open. The grid will show all items having the given tag

Multiple Tags

When selecting 2 or more tags, the items shown can be:

All items that have all the selected tags, or

All items that have one of the selected tags

Right-click > Logical AND / OR to select the output mode. 

When the grid opens, notice how the grid source reflects that choice. The source can be manually edited to do more fancy filtering, using multiple AND, OR,

NOT. 

You can also filter the result to only items that are also shown in a given grid. To do so:

�. Open the grid

�. Switch to the Tags pane

�. Select tags

�. Right-click > Show Items (Grid Subset)

1.5 Tag Inheritance

Tags have a major feature that fields do not: Inheritance. This means that a parent tag inherits the state of a child tag.

Consider this hierarchy of tags

Animals

Mammals

Feline

Lion

Cat

Canine

Dog

Wolf

Invertebrates

Frog

Pets

Cat

Dog

Wild

Frog

Lion

Wolf

Now, lets assume these items, and tags:

Lassie: Dog

Snoopie: Dog

Garfield: Cat

JackTheWolf: Wolf

Simba: Lion

Notice how tags Cat, Dog, Frog, etc are under 2 parents: under Animals/../.. and under Pets. This means that assigning the tag Cat to Garfield, also assigns it

to Feline, Mammals, Animals and Pets

The Tags pane reflects this inheritance, showing a small check-mark for inherited tags. When the focus is on the item Garfield, the Tag pane shows:



Hint:

At times, Inheritance can get in the way and return too many items. In such cases, it is possible to set the Inheritance Depth (None, 1 through 9, All)

When set to None, IQ Tags function like most other tagging system, returning only the items explicitly tagged

The Tags pane reflects this Inheritance depth setting

Inherited tags are also shown in Flat-view

See the Tags Grid section below to find out how to set a tag under 2 or more parent tags

Using Inheritance

With Inheritance, the search can show items that have not explicitly been tagged with the selected tag, but with a sub tag, sub-sub tag and so on.

In the above example:

Selecting Feline should give Garfield and Simba (even though neither of these items have the Feline Tag explicitly)

Selecting Pets should give Garfield, Lassie and Snoopie

Selecting Feline and Pets should give Garfield

Selecting Wild and Canine should give JackTheWolf

1.6 Copy / Paste Tags between IQBases

It is now possible to copy tags from one IQBase and paste it in another:

�. Set the Tags pane to Tree View (Copy / Paste does not work in Flat View)

�. Select one or more tag branches or press Ctrl+A to select all tags

�. Right-click > Copy Tags

�. Switch to the other IQBase

�. Right-click > Paste Tags

1.7 Viewing Options

Tree-view shows a hierarchical list of all tags. If a tag has 2 or more parents tags, it will be shown under each

Flat-view shows an alphabetical list of all tags. Tags that have sub-tags have nevertheless expand buttons to reveal the sub-tags. 

This means that the same tag can be shown more than once: In the main list, and under each of its parents

Item count for each tag can be turned on/off. When off, they still show on mouse-over when holding the Alt key

Tooltips displays information about the tag under the mouse pointer. Use View > Tooltips to turn On / Off. If Off, hold the Ctrl key to display tooltips

To quickly get to tags, there are commands to Expand a branch, Expand all and Collapse all

The Tags pane has column headers. Click on a header to sort (by name or by number of items)

Locked at the top of the tag list, are the current item tags

1.7. Context Menu



Show Tags in Grid: Shows all assigned tags in a grid column

Show this tag in Grid: Shows a specific tag branch in a grid column

Copy Tags: Copies the selected tags (and sub-tags) to the clipboard. 3 clipboard formats are used

Text: to paste in a text editor

Tab-Indented: To paste in a grid and create a hierarchy of items (i.e. paste in the Tags grid)

Tags: Used by the Paste Tags command

Paste Tags: Pastes the previously copied tags and creates a new set of tags

2. Tags Grid

Tags are just regular items with the field Tags checked and an auto-generated numerical ID (TagID). They can therefore be shown in grids, and in particular in

the Tags grid

In the Tags grid, you can do anything that can be done in grids, some of which are not possible in the Tags pane, namely:

Font Formatting: Size, Bold, Italic, etc

Item color: Back color, Text color

Insert icons

Import Tags from an external file or the clipboard

Copy / Paste tags from one IQBase to another

Move a tag from a parent to another

Set a tag under 2 or more parents

For each Tag, you may enter a description in the Notes field. This will be shown in the Tags pane (as a tooltip)

2.1 Hiding Tags from Tag lists

Over time, you may find that some tags are no longer used. While it is possible to delete these tags, you may not want to lose the tagging information.

A better approach is to archive these tags. InfoQube will hide from tag lists (i.e. Tags pane, Live-Search) all archived tags.

To archive a tag, set  the item font to strikethrough (i.e. SomeTag). Archived tags assigned to items still show in grids and the Properties pane.

To archive tags and hide these from the Tags pane then:

Select one or more items from the Tags grid

Item > Format > Strikethrough (or click the Strikethrough button on the formatting toolbar)

Refresh the Tags pane (as this type of change does not auto-refresh it)

By default, the Tags pane hides archived tags. To show these, do right-click > Show Archived Tags

2.2 Refreshing the Tags pane

The Tags pane will auto-update on most changes to tags, such as adding, deleting and changing the tag name.



Some changes are not currently detected, such as changing / adding parents. To refresh the Tags pane, press F5 (or right-click > Refresh Tag List)

3. Item Tags in the Properties pane and in Grids

A critical feature of a tagging system is viewing item tags, that is, what tags have been assigned to each item.

The Tags pane shows this of course (see section 1 above), but also in:

Properties pane, in the Item Properties > Tags section

Properties pane, in the Current Grid section (if tags are shown as a column in the current grid)

Properties pane, in a form: Add the ItemTags system field to view tags in a form

All Grids, as a column

3.1 Properties pane

The Properties pane has a Tags section which shows tags assigned to the currently focused item. Tags can be removed by clicking on the red x after the tag

3.2 Grid Column

The Tags pane and Properties pane can show item tags for the currently focused item. That is, one item at a time.

Grids however, can show item tags for all items in the grid, which is a big plus !

The listed tags are hyperlinks. Click on one will show all items with that tag

(plus those with parent tags with inheritance set)

The Tags column can be added to any grid, using one of the following methods:

Drag-drop the Properties pane tags section to a grid

Right-click on the Properties pane tags section > Show as a Grid Column

Right-click on the Tags pane > Show Tags in Grid

Grid Column menu > Add Columns... and add the ItemTags field 

For a more concise display of tags, the field ItemTagCount can also be shown as a grid column

These two tag columns can be used to add / remove item tags. Select one or more items and press F2 to show the Tags dialog

The Tags dialog is very similar to the Tags pane:



A specific branch of the tag hierarchy can also be shown as a grid column. For heavy tag users this is a big plus as it becomes much easier to select tags

from a limited list. Combined with multiple parent tags, this allows great flexibility

To view a specific tag branch, right-click on a tag (e.g. YourTag1) in the Tags pane and select "Show this tag in Grid". A new column will be shown in the grid

with the name Tag: YourTag1. While on this column, pressing F2 (or Edit > Edit) shows a tag selector dialog filtered to only show the YourTag1 branch.

n.b. In Tools > Options > General > Grid, it is possible to hide the red x after tags, for a cleaner look

3.3 Copy / Paste / Delete Tags

The Tags section of the Properties pane and the Tag columns in grids also support cut / copy / paste / delete operations. 

This can be a real time-saver when items have many tags. Steps are:

�. Select a the item's Tags column

�. Edit > Copy

�. Select 1 or more items, in the same grid, or in another grid

�. Edit > Paste or Edit > Paste Special > Item Tags

�. All selected items will now have the same list of tags

�. Tags can also be deleted in bulk by selecting a set of tag cells (in a grid) and hitting the Delete key

In the Properties pane, the process is very similar. 

When copying / pasting whole items (i.e. XML mode copy -- bad name, to be renamed eventually), tags are treated just like fields and new items will have the

same fields and tags

4. Using Tags as Filters in Grids

We're already seen that tags can be shown as a column in grids. There is however lots more to tags. In fact, tags can be used much the same way Y/N field.

To reference a tag, use of the following syntax:

#TagName

#[TagID]

#[TagID:TagName]

The advantage of using TagID is that tag name change has no impact.

Use the #[TagID:TagName] format to have a reminder of the tag name. TagName is for reference only and may not reflect the actual tag name if it has been

changed.

Support for tags include:

�. As Grid source: e.g. #Tag1 AND #Tag2. Items added to the grid will have the tags automatically assigned

�. As Grid filter

�. In the Auto-assign field list (Grid > Properties > Data)

Tags are however different than Y/N field in the following ways:

Tags are shown in a single column, while fields are shown in individual columns

Tags in grid source and filter support inheritance which fields do not. The tag inheritance depth is set in Grid > Properties > Data

To specify that items must not have a given tag, the syntax is NOT #TagName (e.g. (#Tag1 OR #Tag2) AND NOT #Tag3). For fields, you would use [Field1]

is Null

Tags do not have row and equations, nor do they have auto-assign rules. Fields can however assign tags in their auto-assign rules



5. Live-Search using Tags

The Live-Search shows a Tags column and a Tags list on the left side of the window:

To use Tags in Live-Search:

Double-click on a tag to show all items with that tag, or

Use the checkbox to select 2 or more tags

When 2 or more tags are selected, output is either:

Logical OR: Items that have anyone of the selected tags

Logical AND: Items that have all the selected tags

In Logical AND mode, the tag list updates to only show relevant tags, that is, tags that the current list of items have

Much like the Tags pane, right-click on the tags list to set the Inheritance depth

The Tags column shows the item tags. Click the red x to delete a tag

The Live-Search has 2 output modes: Item List or Live-Search

See the Live-Search page for more details: 1. Live-Search

6. Linking Fields and Tags

Tags are new and many users have invested significant time in creating a perhaps large set of fields, mostly of Y/N type. 

A large number of these fields may benefit from the advantages of Tags (see the next section)

It is possible to quickly assign a tag to all items that have a specific field. There are numerous ways to do this. One would then delete the field, since no

longer of any use

An alternative approach, particularly useful when transiting from fields to tags is to link the two. Tags cannot set field values but fields can set tags

So using a simple auto-assign rule, it is possible to update 1 or more tags whenever a field is changed, hence linking fields and tags. 

To do so, in the field auto-assign section enter:

A:#TagName | E:#TagName=0

If TagName is the same name as the field name, you essentially have a field and a tag with the same name and the tag will match the field value

7. Comparing Tags to Y/N Fields 

Tags and Y/N fields are indeed quite similar

Tags Pros are:

Quicker to create, search, sort, view count

Integrated in Live-Search

Support Inheritance and multiple parents

Shown as a single column in grids

Specific branch of the tag hierarchy can be shown in a grid column

Tags cannot trigger Auto-assign rules but the field ItemTagCount  can. Use this field to trigger actions whenever item tags are added / removed. For

example, the rule  M:[Notes]=[ItemTags] will save the list of tag in the Notes field

Y/N fields Pros are:

Support Equations and Auto-assigns

Conditional Formats

Visible to other apps, such as Excel

https://infoqubeim.com/863
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Links

InfoQube provides many ways to link pieces of information:

�. Hierarchy: Parent -> multiple children, Child -> multiple parents

�. Hyperlinks to:

Items

Grids

Fields (shows all items that have values for that field)

WikiTags (shows all items that have a specific WikiTag)

Files and Folders

URLs

Outlook items (email, event, inbox, etc)

Other apps items, using their URI protocol

�. Links to files and URLs using FileRef, FileName, FilePath, FileFullName and URL fields

�. Related Items links: Ad-hoc bidirectional links between items. "See also" type links

Many UI elements support 1 or more types of link:

Grids: All links except Child -> multiple parents (see section 1. below for details)

Calendar: Hyperlinks

IQ Surface: All links except File and URL field links

Map View: All links except File and URL field links. Multiple parents are shown for the map center (or start) item only

Timeline, Pivot Table and Chart do not show links

Home page: Hyperlinks (links to many InfoQube elements (items, grids, grid groups, UIs)

Properties pane: All link types

Doc pane: Hyperlinks, Related Items

Favorites items: Direct link to user-defined favorite items, shown in their Home view

1. Hierarchy: Parent -> Children, Child -> Parents

Items can have any number of children (i.e. sub-items). Children are shown in many UIs (see previous section)

Items can have any number of parents. One of these is designated as the main parent. The main parent is shown in the grid when Grid > Context

Parent is checked

If more than one parent item are shown in the same grid, each of these items will show their child items. This means that some child items may appear

more than one in the grid. This is by-design

For example, if John and Anna had a son named Sammy, later on divorced and met Mary and had a child named Julia, we would have:

Anna

Sammy

John

Sammy

Julia

Mary

Julia

Child -> Parents: There are many ways to add one or more parents:

Grids: Drag-drop

Select one or more items. Click on the text of any of these, hold the button for a fraction of a second and drag to the new parent.

If the new parent is shown in another grid, drag to that tab to show the grid and then drag to the parent

Drag the item(s) to the lower half of the parent item (cursor will change to show a sub-item). Hold the Ctrl key (the icon will show an

additional + sign) and Drop

Grids: Use Marked Items: : See Marked Items and 9. Item Menu

First mark the child items (Item > Mark Items). Then select the "to-be" parent item and do Item > Add Marked items as children

Grids: Copy / Paste: Select the item and copy in XML mode (in the copy dialog). Then on the "to be" parent item, do Paste and select the second

option

Surface: This view excels at handling multiple parents. One way is to right-click from the "to-be" parent to the child. See 3. IQ Surface for details 

2. Hyperlinks
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Hyperlinks can be made to just about everything.

To create a hyperlink, select an item or text within an item and do Item > Hyperlink (Ctrl + K). A dialog will be show to define the hyperlink:

Details here: Hyperlinks

3. Links to Files, Folders and URL's

The hyperlink dialog above can be used to link to files and URLs but offers few options.

The better way is to use the File / URL Link dialog. To show the dialog, use one of:

Drag-drop a file on a grid

Copy/paste a file from File Explorer to an item on the grid

Details here: Link to Files, Folders and URLs

Related Items Links

Related Items are ad hoc bidirectional links between any 2 items, similar to "See Also" links seen in help files and documentation.

Related Items links can be shown in many UIs, including grids, the Properties pane and the Doc pane:

Details here: Related Items Links
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Hyperlinks are supported in just about all UIs, shown as blue text: 

Hyperlinks can point to:

�. Items

�. Grids

�. Grid sub-views (i.e. Card view, Map view, Timeline view, Pivot table / charts)

�. Fields (to show all items with a value for that field)

�. Tags (to show all items with that tag)

�. WikiTags (shows all items that have a specific WikiTag)

�. Files and folders

�. URLs

�. Outlook items (email, event, inbox, etc)

��. Other apps items, using their URI protocol

1. Creating Hyperlinks

In grids, select the text cell to hold the link and do Item > Hyperlink (Ctrl+K). If in edit mode or in the Doc pane, you can select part of the text (ex: Microsoft

as seen above)

For other UIs (and in grids), the Popup Editor can be used to create links. Details here: 3. Popup Editor

The Hyperlink dialog will open when you can:

Browse for item(s)

Browse for a file

Link to the list of marked items

Drag-drop or copy-paste a file or URL (i.e. from File Explorer or a web browser)

Manually add one of the the following:

�. One or more Item IDs, comma separated. Use Edit > Copy > Item IDs to copy the selected items IDs to the clipboard

�. When linking to a single item, you can specify the grid, such as 1280|Inbox
�. Grid name

�. Grid name followed by | and one of CV, MV, TL, PT, PC to link to a grid sub-view (i.e. Card view, Map view, etc)

�. Field name (enclosed with [square] brackets)

�. Tag name (preceded with #)

�. Wikitag (enclosed in {curly} brackets)

�. File (path and name)

�. Web Address/URL

��. URI shortcut from another app (such as AnApp://C:\Data\EPIM\SomeApp.ext/mails/5894593485)

Drag-drop an Outlook item

https://infoqubeim.com/142


When WYSIWYG editing is turned off, hyperlinks can also be entered manually. Format of a link is <a xxx>Link Text</a>

When WYSIWYG editing is turned on, entering something that looks like a web page will automatically create a hyperlink

Other ways to create hyperlinks to items are:

Select 1 or more items. Edit > Copy Special > Copy as Hyperlink. If more than 1 item is selected, a dialog is shown to choose the hyperlink type. Then

Paste will add the hyperlink(s)

Select 1 or more items. Item > Mark items (Replace). Then do Item > Mark Items > Add Hyperlinks to Marked Items

Select an item and press Ctrl+C. In another item, Press Ctrl+K to open the Hyperlink dialog:

In Hyperlink Text, press Ctrl+V to paste the item text

In the Target, press Ctrl+V to paste the item ID

2. Creating IQ:// protocol links (i.e. URI links)

If the content is to be used outside of InfoQube, it can be useful to use URI links instead of regular links.

The format is: IQ://C:\SomeIQBase.sndb/items/ItemID, or

/items/ItemID1,ItemID2, (...)

/views/Surface

/views/Calendar

/views/ViewName

/views/ViewID

 To copy the link to the clipboard:

Select one or more items and do Edit > Copy > Copy Item URIs

Right-click on a tab > Copy View

The clipboard will now contain a universal link, such as: IQ://C:\Users\AUser\Documents\IQBases\JohnDoe.SNDB/items/1580

Switch to the other application and do Edit > Paste (or similar command)

To test a link, enter it in the address bar of a browser and hit Enter. Focus should switch to the link target (item, grid, etc)

3. Removing Hyperlinks

Use one of:

Item > Remove Hyperlink

In the Hyperlink dialog, click Delete

Manually remove the <a> </a> tags (non-WYSIWYG editor)

Note: Item text can contains more than one hyperlink. When not in edit mode, using the remove hyperlinks commands removes all hyperlinks. Switch to edit

mode to remove only one of the hyperlinks

4. Using Hyperlinks

In grids (not editing), the Properties pane, the Doc pane (browse mode), Calendar and other UIs, simply click on the link. While editing in the Doc pane, use

Alt + click to navigate the link. The action will depend on the link type:

Focus moves to another item

A grid will open

All items with a specific Tag or Wikitag will be shown



A file will open in its native app

A web page will be shown in the default browser

An item in another app will be shown (defined by the URI link)

4.1 Hyperlink menu

It is possible to show a menu of commands instead of the default link action. To do so:

Hold the shift key when clicking on the hyperlink, or

In Tools > Options > Program > Grid, check the option to show the menu (1.2.30)

Either way, a menu will show with the following list of commands:

�. Follow Link:  Same as default action)

�. Edit Text:  Enters Edit mode

�. Change Link...:  Shows the Hyperlink dialog

�. Remove Link:  Deletes the hyperlink

�. Cancel

5. Notes

Microsoft Office (v2007 and up) no longer automatically register the Outlook link protocol (see this reference).

If not registered, the link will not work. To register the link, run the OutlookProtocol20XX.reg file supplied (installation folder), where XX is your Outlook

version

Outlook has been known to change its GUID  ("global unique identifier") when Outlook items (contacts, emails...) are moved around. If the GUID is

changed, the link will not work
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Hyperlinks can point to a large range of things: items, grids, files, URLs, etc (as described here)

While the Hyperlinks dialog can be used to link to items, InfoQube provides a specific UI to streamline the process: The Item Links dialog:

This dialog is available in grids, Doc pane and Item Editors.

1. The Item Link dialog

http://support.microsoft.com/kb/929590
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The dialog contains the following:

Search text box. This is where the user enters text

Scope box. Select from (All Items), (Recent Items), (Current Grid) or from a specific grid

Result list. Shows matching items plus an entry to add a new item. Press the space bar to select / unselect items

Preview. Shows how the link will look, depending on formatting options (see below)

Use Item Text checkbox. If not checked, the link text will be a fixed linked text, not the item text

Create Related Item Link. If checked a Related Items links will be created for each selected items. Details here

In the overflow menu, users can set the fixed link text, whether to enclose with [[ ]] or not and the number of items to show for Recent Items

2. Creating Inline Item Links

While editing in a grid or a Doc pane / Item Editor simply type [[ to open the dialog

Select the scope if it isn't the same as the previous time

Enter some text in the search text box. Precede with a * if the text can occur anywhere. Remove the * if it must start with the text

The result list will update. If searching all items, you must enter at least 3 characters to search

Select one or more items from the results list. To select, click on the check box or press the space bar

To link to a new item, select the (new item) entry or press the Insert key

The Preview will update. Change the formatting options if required

Hit Enter or click OK to confirm.  Hit Escape or click Cancel to cancel

Tips and Tricks:

If the search result list includes the current item, it will be un-selectable and shown with a different checkmark

The dialog itself can be resized using Ctrl+Arrow keys and moved using Shift+Arrow keys

The Up / Down arrow keys can be used to navigate between items and between the various UI elements the dialog

Holding the Alt key will show the item ID. Useful to identify items with same or similar item text

If items have been copied (Edit > Copy or Ctrl+C), press Ctrl+V to add and select the item(s)

It is possible to toggle the search scope (i.e. between a specific grid and all items). To do so, either click on the result list header or press Ctrl+I

When no items are found (i.e. result list is empty), it is also possible to toggle the search scope by hitting the Enter key

When items are found, Enter will switch back to searching a grid if less than 3 characters are in the search text box

If only one item matches the search, hitting Enter will select it. Hit Enter again to save and close the dialog
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Links to Files, Folders and URLs

1. Links to Files and Folders

An item can contain links to files and folders. To create such links, use one of the following methods:

�. Drag-drop files and folders from File Explorer

�. Copy - Paste files and folders from File Explorer

�. Create a hyperlink

�. Use the New Item dialog

�. Manually fill file-related fields

1.1 Drag-drop files and folders from File Explorer 

When dragging a file or folder from File Explorer the following dialog will be shown:
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There are 5 parts to the dialog:

�. Item Text: defines the text that will be used for the link: manually added text; file path; and file name (in that order)

�. What do you want to do? : 

Create item: 1 item will be created for each file as in:

Add to the current item: Hyperlinks will be appended to the current item as in:

�. Link should point to:

Actual file

Shortcut to the file: a shortcut to the file will be created and saved in the .Files folder (yourfilename].SNDB.Files)

This second option has the advantage that the file will be found even if it is moved (within the same partition)

�. Item Hyperlinks: Should the item text include a hyperlink to the file?

No Hyperlink: Double-click on the item to open the file

Static: hyperlink to the file (hard-coded link)

Dynamic: link target saved in a field (see #3 immediately below). The actual item text (in edit mode) will be

<a href=[FileFullName]>Link C:\My Documents\YourFile.htm</a> using the File link fields

<a href=[URL]>Link C:\My Documents\YourFile.htm</a> using the URL field

�. File location stored in: There are 4 ways to save links in IQ:

None (hyperlink only): File link is embedded in the item text, as a hyperlink, but not in a separate text field

File link fields:

3 fields will be filled: FileRef, FilePath and FileName (FileName will be blank if you dragged a folder)

In addition, the calculated field FullFileName will be updated. This field is by default a hyperlink, so a single-click will open the file/folder

The advantage of using the File link fields is that file name and path are separate so various update operations are sometimes simpler

URL field: a single field (hyperlink type) containing the full file name (for files) and web URLs

HTML Pane: File name will be saved in the field ItemHTMLFile. For many file types, this will show the file in the HTML pane. Details here: 4.

Document Pane
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If you drop a PDF file, it will be displayed in the HTML pane and the text content will be extracted and be searchable within InfoQube

If you drop a folder, IQ will show an File Explorer view of the files

If you open one or more Image Viewers, the selected file will be shown in the viewer (for image type files)

Click the Back button to move to the Parent folder (Ctrl + left arrow).

Focused file is shown on the URL toolbar

1.2 Copy - Paste files and folders from File Explorer

Files and folders can be copied directly from File Explorer:

�. Select 1 or more file or folder

�. In any text cell, do Edit > Paste > Paste Special. This dialog will show:

File List: The Add File dialog shown in section 1.1 above will show. Refer to that section on how to use it

File Name: The name of the selected files will be pasted in the cell

File Hyperlink: Hyperlinks to selected files will be pasted in the cell

Tips:

Relative links are supported. The advantage of relative links is that they'll will work even if the IQBase is moved or if on different computer. To change

an absolute link to a relative one, edit the FilePath field (for 1 or more items).

A few examples using D:\Data\Shapefiles\Landuse as the IQBase folder are:

..               (D:\Data\Shapefiles)                     Parent folder 

..\..            (D:\Data)                                GrandParent folder 

..\..\Final\     (D:\Data\Final)                          Uncle folder 

.\..\Soils\      (D:\Data\Final\Soils)                    Cousin folder 
otherData\       (D:\Data\Shapefiles\Landuse\otherData)   Child folder

 (from: Methods for Importing Data into IQ)

2. Links to URLs 

An item can contain links to web pages and other URLs. To create such links, use one of the following methods:

�. Drag-drop URLs from your browser

�. Create a hyperlink

The Add URL dialog will show:

https://infoqubeim.com/82
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This dialog is very similar to the Add File one with the following differences:

Dynamic Hyperlinks are not available

File link fields are not available
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File link example: Image Viewer

Don't we all have zillions of digital photos. And each camera we buy comes with this semi-useless software to manage your photos...

InfoQube can help in viewing and organizing photos:

Drag-drop files from Explorer to create items with links to the files. In the File link dialog, select File Link Saved to: File link fields

In a grid, you have user-defined columns to describe the photo (date, who's there, where, rating, etc)

You can add additional information as sub-items (click on the + to see the details, as in Windows Explorer)

You can sort, filter, group easily

A built-in image viewer, which rotates to show constant size (portrait vs landscape)

Double-click on the image will lock the viewer on this photo. Open another viewer to view other photos. You can open as many as you wish (Now you'll like that 21" screen!)

If many viewers are opened, as you scroll in the photo list, a different viewer is selected to show the photo. So the last few photos are always visible. Great when a group of people are

looking at them.

Image file is not imported, IQ creates a link, so the IQBase file remains real small

No imaging editing tool included (would be second rate anyway). You use the editing tools that you prefer! Double-click the item in InfoQube to open it.

You can create many grids where you see some or all of your pictures. Great to view the same photo in different contexts (without making copies) 

i.e. The grid of the best photos of my 4 year-old and the grid of photos of our trip to the east-coast, some of the photos will be the same. No problem!
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Related Items are ad hoc bidirectional links between any 2 items, similar to "See Also" links seen in help files and documentation.

1. Adding Related Item(s)

To add Related Items links, use any of the following methods:

Select two or more items and do Item > Link Items (Ctrl+R). All selected items will be mutually linked

Select a single item and do Item > Link Items (Ctrl+R). The Related Items dialog will open:

https://infoqubeim.com/drupal5/index.php/pierre
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See 3. Using the Related Items Dialog below for details

Copy / Paste the Related Item links from one item to other item(s)

Copy 1 or more items (Ctrl+C) and paste in the Related items grid column (Ctrl+V)

Use Marked items:

�. Select one or more items from any View (Grid, Surface, Calendar, TimeLine, MapView, CardView)

�. Mark items. (Item > Mark Items, or Ctrl+Shift+M). Details here: Marked Items

�. Select another item

�. Add as Related Item. (Item > Mark Items > Add Marked Items as Related, or Ctrl+Shift+R, or Properties pane context menu)

2. Viewing Related Items

Related Items can be viewed in a number of ways:

�. Properties Pane

�. Grid Column

�. More Info Pane

�. Related Item Toolbar

�. Status Bar

�. Doc pane (New footer contains "See also" links)

�. Related Items dialog

2.1 Properties Pane

Related items are shown in the Properties pane, as hyperlinks:

Right-click on the header to show related items commands:

�. Copy / Paste Related Items from one item to another

�. Add Marked Items as Related Items

�. Show Related Items as a grid column (see section 2.2 below)

�. Show listed Related Items (in a Scratch grid)

�. Mark listed Related Items. Learn how to use Marked Items here

When the View permits it, selecting multiple items will list related items to any of the selected items

Right-click on a Related Item to show or remove an item, edit item, etc:

https://infoqubeim.com/1720
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2.2 Grid Column

The related items can be shown as a grid column. To show it:

Add the ItemsRelated field (Column > Add Columns...)

From the Properties pane:

Right-click on the Related Items header and select Show as a Grid Column

Drag-drop the Related Items header to the grid

Related items are a hyperlinks. Click on one to move focus to that item

Click on the X to remove individual links

Copy / Paste / Delete all links using standard commands

By default, the column will show each link on a separate line. Toggle Wordwrap to change this

The number of related items can also be shown as a grid column. To show it:

Add the ItemsRelatedCount field (Column > Add Columns...)

The # Related cell is a hyperlink. Click will show related items in the Scratch grid (Hold Shift to show it in a new Scratch grid)

The cell tooltip shows the list of related items:

Hint: Hold Ctrl while hovering over the cell to show the tooltip if tooltips are Off 

2.3 More Info Pane

The More Info pane can also show the list of Related Items as a hyperlink list:
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To show Related Items, right-click on the pane and ensure that the mode is "Show Selected" (i.e. not Show Mouse-over)

2.4 Related Items Toolbar

Right-click on the main menu will bring up the Toolbar context menu from which you can show / hide the Related Items toolbar:

Select one or more items and the Toolbar will show all related items. Click on one to move focus to that item:

2.5 Status Bar

The status bar can show the item lineage (parent tree), but can also show related items

To do so, double-click on the status bar until related items are shown:

Click on one to move focus to that item.

n.b.: The status bar can show the first 9 related items only

2.6 Doc pane

In Browse mode, the Doc pane will show a "See also" footer containing the list of linked items:

3. Using the Related Items Dialog

The Related Items dialog is a non-modal floating window showing the items related a given item. To show it, select an item in any view (grid, Calendar,

Surface, etc) and do Item > Link Items (Related) (Ctrl+R)

The dialog will open:



The dialog is divided into top and bottom panes

The top pane is used to find items

The bottom pane shows the items currently related to the item

In either pane, toggle the checkbox to add / remove an items as Related (mouse click or press the space bar)

In the top pane press Insert or select the (new item) line and press Enter to link to a non-existent item.

A dialog will be shown to enter the new item text. Item will appear in the bottom pane in blue text

Changes are only applied when the Save or OK buttons are clicked. If new items are created, these will be shown in your Inbox

The dropdown on the top-right corner can be used to limit the search to items in a given grid or to recently added items

* at the start of the search string will find items that have it a anywhere in the item text

Tips and Tricks:

The dialog is non-modal. This means you can leave it open. It will auto-update if changes are made to the item's Related items

Multiple dialog can also be opened, each showing links for a specific item. Use it as a information / navigation tool

To save the changes without dismissing the dialog, click the Save button (or hit Ctrl+S)

Double-click on an item in the bottom pane will show that item (in the current view if shown, else in its Home)

If the search result list includes the current item, it will be un-selectable and shown with a different checkmark

The panes can be resized by dragging the divider between the two panes up / down or use the shortcut keys (Alt+Up / Down)

The dialog itself can be resized using Ctrl+Arrow keys and moved using Shift+Arrow keys

The Up / Down arrow keys can be used to navigate between items and between the various UI elements the dialog

Holding the Alt key will show the item ID. Useful to identify items with same or similar item text

If items have been copied (Edit > Copy or Ctrl+C), press Ctrl+V to add these items to the Related Items list

It is possible to toggle the search scope (i.e. between a specific grid and all items). To do so, either click on the result list header or press Ctrl+I

When no items are found (i.e. result list is empty), it is also possible to toggle the search scope by hitting the Enter key

When items are found, Enter will switch back to searching a grid if less than 3 characters are in the search text box

If only one item matches the search, hitting Enter will select it. Hit Enter again to save and close the dialog
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Editing items

Item text and other field values can be editing in most views and in the Properties pane:

�. Grids

�. Map View

�. IQ Surface

�. Calendar

�. Card View

�. Item Editor
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Grids have in-place editing (in both plain text and WYSIWYG). In other views the Pop-up editor or the Item Editor can be used to edit. Use Shift+F2 / Ctrl+E to

open these

1. In Grids

Grids is the most common way to view and edit items. It has view and edit modes. Press F2 to switch between the two: 

When editing, the left-right cursors/ is limited to the cell.

The up-down arrows are limited to the cell if the Up/Dn button on the status bar is enabled ( ). Otherwise they will end editing and move the focus to

the prev/next item

When editing a text cell using the WYSIWYG editor, Alt + up-down arrows changes the size of the editing window

When not editing, all cursor keys enable quick movements between cells

When over a text cell, the OVR status bar button (Overtype) sets what happens when you start typing:

OVR On: will replace the content with the new text (press ESC to cancel it if not what you wanted)

OVR Off: will append your new text. No need to scroll to the end

For non-text cells (number, date), Overtype is always On

For number cells, pressing an operator will enter equation mode. For example if 10 is in the cell, pressing +5 will write =10+5. Hit Enter to do the

operation. Operators are the standard + - * /

F2 will toggle editing (3 states when a editing form is available, such as for dates)

Shift+F2 brings up a large, resizable, editing window, the Pop-up editor

Ctrl+E brings up the Item Editor, which provides a IU to view / edit common item values: Item text, Doc pane, Notes, URL, Inbox, Due, Tags and Folders

2. In the Properties pane

The Properties pane behaves in a very similar manner as grids, except that fields are shown vertically, instead of horizontally

In addition to field-values, the Properties pane show parents, children, siblings, tags, related

Details here

3. In the Calendar

Double-click, Right-click > Edit Event or press F2 to show the Event Dialog.

To just edit the item text (i.e. the event title), press Shift+F2 to show the Pop-up editor or Ctrl+E for the Item Editor

4. In other views, such as Map View, Card View, IQ Surface

Double-click, Right-click >Edit or press F2 to show the Pop-up editor

Ctrl+E to open the Item Editor

5. New Item dialog

Details here

n.b. Entering Line-breaks

IQ grid text columns have 2 settings that affect how multi-line items are shown (not editing) or while editing

1. Column > Wordwrap:
If Off, multi-line items show as a single line. When editing however, the line breaks will be shown
If On, multi-line items show and edit as multi-line

2. Column > Use WYSIWYG Editor:
1. If Off, the edit box will automatically expand
2. If On, the edit box automatically expand. use Alt + Down arrow to increase the edit box size. 

The advantage of the WYSIWYG editor, apart of being WYSIWYG of course, is that it supports spell-check !
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Favorite Items

Favorite items provide a way to easily access items you use most. The list is saved in the field Favorites.
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1. Setting an item as a Favorite item

Select one or more items and:

Do Item > Favorite to set as a Favorite

Set the Favorites field (Properties pane)

2. Removing an item from the Favorites list

Use one of:

View > Favorites and right-click on an item > Remove item from Favorites

Select one or more items and do Item > Favorite to toggle the state

Select one or more items and uncheck the Favorites field (Properties pane)

Since the list is saved in the field Favorites, so you can quickly add/remove items to your Favorite list using IQ grids, auto-assign, etc

3. Viewing Favorite Items

To view Favorite items, do View > Favorites (or click on the Favorites icon). The list of Favorite items will show:

Selecting an item in this list will show the item. To decide where to show the item, InfoQube uses the following order:

�. In the current view if the item is visible

�. In it's home grid if it is defined. If the item is not visible in that grid, a Hoist will be performed to show it

�. If the home is not defined, the item is shown in the Scratch grid

4. Working with many Favorites

If you like having many Favorites, using the Favorites dropdown menu may not be very efficient (as the dropdown can only show a flat list of so many item

and scrolling is possible but not very quick)

A more efficient method uses the power and flexibility of grids. It involves creating a grid to show favorites and assigning a few keyboard shortcuts. The

steps are:

�. Create a new grid named Favorites (or use another name but set the source to the field Favorites)

�. The grid will open with the list of your current favorites item

�. To view a flat list of favorites item, set the following grid display options: Flat view, No context parents and Column > Auto-size widths

�. You may also want to set up a grid column sort (see 5. Sorting and Grouping Items)

�. Enable Auto-Search on the Item column (Grid > Auto-Search, see 2. Grid Auto-Search)

�. Make the display as narrow as possible by hiding / removing all columns except the Item column and set the column wordwrap off

�. Right-click on the tab and select Detach tab. The Favorites will appear in a pane docked at the far right of the IQ window. Resize / move it to your liking

�. In Tools > Manage Grids, select the Favorites grid and assign a keyboard shortcut for this grid (Options > Shortcut). Enter a number between 2 and 9 (1

is reserved for the Home Page)

�. Lastly, assign a keyboard shortcut to Item > Show in Home View command, such as Ctrl + Shift + O (see Keyboard Shortcuts)

To view a favorite items then:

�. Press the Favorites grid shortcut

�. Scroll to the item or start typing a few characters until the correct item is selected (below "Cal" was typed)

�. The Properties and Doc panes will update. To view it in its Home, press the Show in Home View shortcut
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Hint: As this grid and the Tags pane are both typically narrow list of items, the two can be grouped in a pane group. Shortcut keys still work and will bring the

respective pane:

5. Notes

Shown in parenthesis ( ) is the item Home. See Item Home for details

Favorite items can also be shown in Live-Search. Click the star icon to show
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Item Home

Items in InfoQube are like individuals, you and me. They have characteristics (field-values), parents and children (sub-items).

Until now however, items didn’t really have a “Home”.

Setting an item as a Favorite did set the ItemHomeGrid which was later on used when showing the item, but that was good for only a small number of items.

Favorites being shown in a drop-down menu, it is a good idea to limit its use somewhat.

Items now have a real “Home”:

Homes are automatically assigned, on item creation

Default Home is the view where the item was created

The Home can be changed at anytime

Currently, the Homes can be:

Any Grid

The IQ Calendar
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The IQ Surface

From EmailToIQ

1. Viewing Item Home

The item Home can be viewed in the Properties pane and in grids.

In the Properties pane, the item Home is shown in the Item info > Item Properties section

In grids, show the ItemHomeID field (or right-click on the Home in the Properties pane and select “Show field in the current grid”)

2. Changing the Item Home

Just as you can move to a different home, so can Items.

To change the item Home, click the drop-down button (Properties pane or grid) and select the new Home. F2 is the default shortcut.

3. Using the Item Home

The item Home is shown as the name of the view but internally is it saved as the ID of the view:

For grids, the ID is shown in Manage Grids (positive number)

The IQ Calendar ID is –1

EmailToIQ ID is –2

The IQ Surface ID is –3

The Home ID can be used like any other field inside IQ. It can be the source of grids, used in filters etc. The actual field name is ItemHomeID

Prior to Item Home, it was sometimes difficult to have a flat view of all items in a grid. Workarounds were:

Assigning a field-value to all items, either manually or automatically (using grid properties) and setting the grid source to this field

Doing a Hoist with all items selected and switching to Flat view

Now users have another way, using item Home. Keep in mind though that in IQ, items shown in a grid were not necessarily created there, but anywhere

inside IQ. Filtering on item Home therefore serves a slightly different purpose.

4. Viewing items in their Home

The main purpose of item Home is of course to show items in their most appropriate context, so hyperlinks will show the item :

In the current grid if the item is already there

in their Home, if the Home is a grid

In the Scratch grid, if the item doesn't have a Home (i.e. created before this feature was implemented) or the Home is not a grid

5. Viewing all items in a Home

A "real" Home is where family members live... you can have visitors, but family members tend to stick around there.

In IQ, views are more changing and dynamic, so they can display any item whatsoever. And Home members may not be shown for a long time.



So, to view all Home members (i.e. all items created in that grid / view), you can do one of:

Select an item that belongs to this Home, open the Properties pane and double-click the Home.

The Scratch grid will open, showing all items

Set the source of a grid to ItemHomeID=XYZ, where XYZ the the Home ID (see above)

Setting the display mode to Flat list or Tree view is generally preferable to the default Outline view (Grid > Display mode). Details here
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Item Join and Split

Content is often entered in a hurry and some re-organizing may be required later on. These include:

Join 2 or more items into a single one

Split one item into 2 or more items

Currently the only view that supports Join and Split is the Grids.

1. Joining Items

�. In a grid, select 2 or more items

�. Item > Join Items.... (Ctrl + Shift + J)

�. Select the delimiters to be inserted between items. Use <tab> or <cr> to insert a tab or a new line between items

�. Select whether the HTML pane content is to be merged or not and if merged items are be deleted or not

�. Click OK

Notes:

The order items are selected determines the order their content will be joined

If Delete merged items is checked, ensure that the first selected item is the one you want to keep. All other items and their associated field-values will

be erased

2. Splitting Items

The Split Item command behaves differently depending if the item is in edit mode or not

2.1 Splitting while Editing

�. In edit mode, place the cursor at the splitting point

�. Item > Split Item (Ctrl + Shift + S)

�. A new item will be created containing the text after the cursor

2.2 Split Dialog

�. Select 1 or more items
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�. Item > Split Item (Ctrl + Shift + S)

�. Select the delimiter to be used when parsing. Use <tab> or <cr> to parse on tabs or new lines. In the above example, the delimiter is ", "

�. Select other options

�. Click OK

Tips and Tricks

To split an item into many items, a quick way is to add parsing tags (such as ||) within the text and then split the item

The Join and Split commands work on the tree column only. This is typically the Item text field. 

It is however possible to execute these on any other text field if required. Simply show that text field in a grid and set it as the tree column
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Marked Items

Using Marked Items

Marking items is a means of selecting one or more items.

It is similar to regular item selection except that:

It is persistent in that marked items remain as such until replaced with other items

The list of marked items is shown in the Properties pane

To mark items:

�. Select one or more items in any UIs (Grid, Calendar, Surface, Live-Search)

�. Do Item > Marked Items > Mark Items (Ctrl+Shift+M)

�. Mark Items will first clear the list. To add, use Add to Marked Items instead

Once items are marked, you can:

Add these as sub-items of the currently selected item. Doing this on more than one item will assign multiple parents to these items

Add these as related items to the currently selected item. Details

Show these in a grid (right-click Marked Items in the Properties Pane and select View Marked Items: they will show in the Scratch Grid

Show these in the Live-Search. Details

Create a hyperlink to these items using the Hyperlink dialog. Details

Hoist any grid to show marked items. Details

Two more Marked Items commands can be added to the menus:

Add Hyperlink to Marked Items: Inserts hyperlink in the current item

Clear list of Marked Items
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